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About Software Copying

Thank you for purchasing SuperLab Pro, an

experimental tool we hope will serve you well.

SuperLab Pro is the result of long, long hours of work.
We’ve put a lot of time into it so you won’t have to.
And we’d like to continue improving it and imple-

menting your ideas and suggestions.

So please, we plead with you, if you must show
SuperLab Pro to a friend or colleague, give them a
demonstration version, not the fully functional version,
or ask them to download the demo from our web site
(http://www.cedrus.com). Giving away the fully
functional version, in addition to being unethical and a
punishable crime, results in fewer sales and discourages

us from continuing to support and improve the product.

Thanks again for choosing SuperLab Pro. We wish you

success in your work.



“I had cleaned my bedroom, and went all around
the room. I came up to the couch, and could not
remember whether I had dusted it or not. Since
these motions were habitual and unconscious, I
couldn’t even perceive that it was now impossible
to remember them. So if I had already cleaned
the couch and forgot about it — that is, if I had
acted unconsciously — it was as if I had never

done it.”

— Leo Tolstoy



Chapter 1 - Introduction

What you can do with it...

What you cannot do with it,
and why...

Welcome to SuperLab Pro.

SuperLab Pro is a tool for setting up and running psychology experiments.
With its various built-in editors, you can interactively set up an experiment that
presents visual stimuli on a monitor and auditory stimuli over headphones.
SuperLab Pro collects the data for you with one millisecond accuracy or better,
depending on the input module you use.

Use any Macintosh PICT file as a visual stimulus.
Overlap more than one picture to form a visual stimulus.
Edit the size and position of pictures forming a stimulus.
Play any System 7 sound file, including stereo.

Edit the screen’s background color.

Choose from different timing and input options.

Present visual stimuli the screen near-instantaneously.
Provide feedback to subject based on the response.

Save your experiments as a readable text file.

Works on any Macintosh model, from the Plus and on.

Cut and paste, point and click, the Macintosh way.

O oOoooogooooogogoo o

Do all of the above and more, interactively and easily.

You cannot create your visual or auditory stimuli from within SuperLab Pro.
You have to create and edit them using other programs, then import them into
SuperLab Pro. The logic behind this decision is that there are good graphics
and sound packages on the market, and it would not have been worthwhile
reinventing the wheel.

Currently, you cannot use conditional branching, although this and other
features are being planned for a later version. Conditional branching would
allow a trial to decide the next trial to execute, instead of going sequentially, e.g.



do trial A if response is correct, else do trial B.

If You Hate Reading Manuals...

To run an experiment...

But to develop an
experiment...

...then please read at least this section.

Using SuperLab Pro, while easy, assumes you are familiar with the Macintosh
and some standard techniques, such as using the menu bar, opening and saving
files, double-clicking, etc.

If all you will be doing is running experiment scripts already written for you,
using SuperLab Pro is straightforward. Just run the program, choose Open
from the File menu to load the script file, and then choose Run from the
Experiment menu. That’s it!

If you will be developing new experiments, you should be familiar with the
terminology and a couple of new concepts that SuperLab Pro introduces. It is
strongly suggested you spend some time going through at least the rest of this
chapter and the next one, “SuperLab Pro Basics.”

Beyond the “SuperLab Pro Basics” chapter, the rest of this manual is mainly a
reference.

Installing SuperLab Pro on Your Macintosh

The distribution diskette may contain a Read Me L= Suverlab 1.4 diskelte E25E
file. If that is the case, read it before proceeding =
any further. It contains information that did not & ]

make it into this manual. It is a text file you can S s

read with any word processor, including Apple's
TeachText program. LetterRotation ]

k2] [

To install:

O  In the Finder, choose New Folder from the File menu. Give the newly
created folder a name, say “SuperLab Pro Folder.”

O Insert your SuperLab Pro distribution diskette into a floppy drive. You'll
find in it the application program, a sample script called Letter Rotation,
and a folder containing visual stimuli.

O  Copy all files in your distribution diskette to the newly created folder on
your hard disk.

If you do not find these instructions clear, please refer to your Macintosh user’s
manual for instructions on how to create a new folder and copy files from one
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disk to another.

The SuperLab Pro application program is really all you need,; files in the Stimuli
folder are used in the next chapter for learning purposes. You can also check
out the Letter Rotation script to help you get started.

Cedrus Support

By Electronic Mail

By Telephone

Credits

By Fax

Cedrus provides three communication channels for asking questions, reporting
bugs, or simply telling us what is on your “wish list.”

In general, if you have a question, please check this manual first; you may find
the answer is already in it. In particular, check the table of contents in the
beginning, the index at the end, and the “Frequently Asked Questions” section
in the “More on SuperLab Pro” chapter.

Additionally, you can also check our Web site. The SuperLab Pro support
section may contain a list of Frequently Asked Questions that did not make it
into the manual. The URL is http://www.cedrus.com.

This is the preferred method. It allows us to archive your questions and
comments faster and easier, gives us more time to research your question, and it
is available to you anytime of the day or the year. The Internet address is
support@cedrus.com. We do our very best to answer most questions via
electronic mail within 24 hours.

The hours are 10 AM to 5 PM Pacific Standard Time (PST) time. The number is
1-800-CEDRUSI (that’s 1-800-233 7871). It is available toll free anywhere in the
United States and Canada. If you are calling from overseas or from the Los
Angeles, California area, the number is 1-310-548 9595.

When calling by phone, we can help you best if the telephone is next to the
computer where SuperLab Pro is installed.

The number is 1-602-631 9047. Please provide both of your phone and fax
numbers.

Where do we begin with the long list of people we owe credits to?

Thanks to our Advisory Committee for conceiving SuperLab Pro and guiding
its development. Its members are: Dr. James Haxby, Chief of the Neuro-
psychology Unit, Laboratory of Neurosciences, National Institute on Aging; and
Dr. Raja Parasuraman, Director, Cognitive Science Laboratory, The Catholic
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University of America.

Thanks also to Dr. Frangois Lalonde from the Laboratory of Clinical Sciences,
National Institute on Mental Health, for his constant encouragement and
numerous suggestions on how to improve SuperLab Pro.

Many thanks also to Dr. Chris Chase, Professor and Researcher, Hampshire
College, for his feedback and ideas.

And of course, we may not forget our beta testers who patiently used the early
incarnations of SuperLab Pro, finding bugs and living through them.

SuperLab User’s Guide



Chapter 2- SuperLab Pro Basics

SuperLab Pro is a powerful yet easy to use tool for setting up and running
psychology experiments. It has several built-in editors that let you setup the
experiment interactively.

In this introductory chapter, you'll learn how to create an experiment. We will
use visual stimuli files provided on the SuperLab Pro distribution diskette. The
experiment will be a smaller version of the Letter Rotation demonstration
included on your diskette. Going through this chapter takes approximately 25
minutes.

To start, run SuperLab Pro. You do that by double-clicking on the program’s
icon in the Finder, or by clicking on it once to select it then choosing Open from
the Finder’s File menu. When the program starts, a window similar to this next
one opens.

Exdperiment Editor - “Untitled.script™

Blocks Trials Stimuli/Events
] ] ]
] ] ]
N "y

This is the main Experiment Editor where all trials are created. The smallest
unit of an experiment is the event, usually a stimulus. A trial is a set of events,
and a block is a set of trials. To run an experiment, you must have at least one
block, one trial, and one event.

Before we start creating events and trials, we need to tell SuperLab Pro what
responses are to be accepted from the subject. In the case of this Letter Rotation
experiment, let it be the letter b for backwards and the space bar for forwards.
To start, go to the Experiment menu and choose Responses Editor. This will
open up another window.



In the Responses Editor window, click on the New L1 Responses Editor

button. A small dialog box opens up. Responses

&
= To define the space bar as a forwards response,
simply press the space bar once. Click on the OK
button. 5

Click on the New button again. To define “b” as a
backwards response, type both lower and upper case b, e.g. bB. This tells
SuperLab Pro that either upper or lower case b is an acceptable response.
Click on the OK button.

That’s it. The space bar and the b character are now defined as responses for
the experiment. You can define up to 46 responses this way, each having from 1
to 7 characters.

Before proceeding any further, let us save what we have done so far. We may
not have accomplished much yet, but it is always a good idea to save, and save
frequently. Choose Save from the File menu. You'll get the following dialog.

<3 SuperLab 1.4

o Dr. Harby's data =— 140 Plus

O Fall '89 stuff _

3 Misc. SL Files Ejeet

0 SL Headers T
__Drlue

O SL Source Code

O Sound f

Save Experiment Script as:

|tut0rial.scrip11 | Cancel

In the edit box at the bottom, type the name you would like to give to the
experiment, say “tutorial.script.” We suggest you always append the name
with the . When you are ready, click on the Save button and SuperLab Pro will
save the experiment to disk.

A couple of things are worth noting here. One, SuperLab Pro saves its
experiments in readable text files, referred to as “scripts.” The manual uses the
term script frequently. And two, the fact that experiments are saved as text files
means that you do not have to use only SuperLab Pro’s editors. Since the file
format is fully described later in the manual, you can use any text editor, word
processor, or spreadsheet program to edit an experiment. And, if you are
handy with programming, you can even write BASIC, Pascal, or C language
programs to generate experiments.

SuperLab User’s Guide



Creating the Back to the experiment; you are now ready to create your first event. In the
Events Experiment Editor window, there are three buttons, New Block, New Trial, and
New Event. Click on New Event. A large dialog box comes up.

In the top left of the dialog box, an edit field is provided so you can type the
event name. The event name must be unique, meaning that, even though a trial
or a block can have the same name, no two events may share the same name.
(Even though SuperLab Pro does not currently enforce this rule, a future release
will.) The same rule applies to trial and block names: no two trials and no two
blocks may have the same name.

For this first event, we would like to greet the subject with some instructions, so
type the word “instructions.”

Time limit:[0 |ms !

(< Accepts user input

End event [ only after criterion response |

Event-Ending Response:
Correct Response:

(File Info] [Feedback...] [ o0k ]| [cancel ]

Fupnl Name

A pop-up menu under the edit field lets you decide what type of event this is
going to be. Currently, four types are implemented:

Auditory

151
Digital Output

5 sl O  Auditory Stimulus. Lets you use any System 7 sound file, including
fost espny stereo and 16-bit sounds, and sounds compressed 3-to-1 and 6-to-1.

Type:

e ] O  Visual Stimulus. Lets you use any standard PICT as a visual stimulus.
B

O  Inter-Stimulus Interval (ISI). Simply introduces a waiting period during
which no responses are accepted from the subject.

O Digital Output. For Macs equipped with a National Instruments” NB-
DIO-24, NB-MIO-16, LabLC, or Lab-NB card, this event allows you to
output digital signals from SuperLab Pro to activate or synchronize
external equipment.

The upper left area of the dialog, called a subdialog area (see above figure), will
change depending on which event you choose. For this tutorial experiment, we
will use visual stimuli only.

In the subdialog area, click on the Picture pop-up menu and choose Open File.
You will be presented with a familiar “get file” dialog:

Chapter 2 - SuperLab Basics 7



Tip: if you run into a
difficulty trying to locate
the file “Instructions”, you
may also insert the
SuperLab Pro distribution
diskette and load the file
from it.

Eant Nams!

At this point, locate the file “Instructions.” If you have followed the installation
instructions in the previous chapter, this file should be in your “SuperLab Pro
Folder,” which in turn contains a “stimuli” folder. Once you have located the
“Instructions” file, click on the Open button.

Now, you are back in the event editor dialog. This is how it should look:

Pict

Event Name: _

e
R A

Type: T R

Time limit: [0 ms [T

[ Accepts user input il

End event [ only after criterion response |

Event-Ending Response:
Correct Response:

(Fite Info] [Feedback...] [ ok ]| [cancel

In the subdialog area, the gray rectangle has been replaced by a “mini” view of
the picture. To see the picture exactly as it will be presented to the subject, do

the following;:

Click on the Picture pop-up menu again and choose Preview Picture.

By default, the picture is centered both horizontally and vertically, and is
drawn at the same it was created with. Both the and size can be edited,
but in this experiment we will use SuperLab Pro’s default values.

When previewing, SuperLab Pro displays in the bottom left corner of the
screen the time it took to display the picture.

When done looking at the picture, click the mouse button or press any key.

You should now be back in the event editor dialog. Click on the OK button.

SuperLab User’s Guide



7

In the Experiment Editor, you will find the event we just created, “instructions,”
listed under “Stimuli/Events” (see picture on the left). Note that it is preceded
by a hollow diamond (<¥). More on that in a little bit.

seript” _______| Our tutorial experiment is to contain four visual stimuli, in addition to the

Stimuli/Events instructions screen in the beginning. To proceed, hold the Option key down
< instructions . . . .

then click on the New Event button. Holding the Option key down is an

optional SuperLab Pro shortcut to help you create the events quicker: instead of
prompting for one new event, SuperLab Pro will keep prompting you for new
events until you click the Cancel button in the events dialog. This saves you
having to click on the New Event button every time.

[cH]

<7

4 The four picture files to be used as visual stimuli are FO, LR30, F180, and RbL60.
Note that, even though these file names may seem cryptic, they are not random.
The first letter indicates the character to be presented to the subject (F, L, or R);
the digits indicate the rotation angle of the letter. When creating your own
experiments with SuperLab Pro, we suggest you use a similarly consistent file
naming convention.

Once in the event editor dialog, proceed as follows. For file FO:
1.  Inthe edit field, type FO.

2. Inthe subdialog area, click on the Picture pop-up menu and select Open
File. This will present you with the familiar “get file” box.

3. Locate the file FO and click on Open.

. 4. Click on the Event—Ending ReSponse Epa apent | anlg afiey (rilevion respanes

pop-up menu. It has two items in it, Event-Ending Response:

Any Key and Correct Key When {orreet Hospoass: ;\<=\=<ﬂz§§ I?:orrec:} key
Stimulus FO Any Key is set, SuperLab Pro will
accept any response from the subject, save it along with the reaction time
to the results file, and proceed with the next event. When set to Correct
Key, SuperLab Pro will still save a response and its reaction time, but
will not proceed with the next event until the subject responds with the
correct key. For this and other events in this experiment, we will choose
Correct Key.

LEG GBENT | GTY 4TIy (THerma v

5. Click on the Correct Response pop-up
menu. In the case of our experiment, you
will find in it three items. The first one,
<None>, is always present. Use it if it does
not matter what the correct response is. The
remaining two, the space bar and the Bb
characters, are what you defined earlier using the Responses Editor. If
you define more responses, they will all appear here in this menu. For
this event, choose the space bar.

fpanpi-fnding Hospoasa: {orres

Correct Response: RSNl

6. We're now done with this event. Click on the OK button to proceed with

Chapter 2 - SuperLab Basics 9



Stimulus RL30

Stimulus F180

Stimulus RbL60
(backwards)

the next one.

If you previously did hold down the Option key while clicking on the New
Event button, you will see the event editor dialog go away and come back
immediately. You're now ready to create the next event, for file LR30:

1.
2.

5.
6.

In the edit field, type LR30.

In the subdialog area, click on the Picture pop-up menu and select Open
File. This will present you with the familiar “get file” box.

Locate the file LR30 and click on Open.

Click on the Event-Ending Response pop-up menu and choose Correct
Key.

Click on the Correct Response pop-up menu and choose the space bar.

Click on the OK button to proceed with the next one.

The next event is F180.

1.  Inthe edit field, type F180.

2. Inthe subdialog area, click on the Picture pop-up menu and select Open
File.

3. Locate the file F180 and click on Open.

4.  Click on the Event-Ending Response pop-up menu and choose Correct
Key.

5. Click on the Correct Response pop-up menu and choose the space bar.

6.  Click on the OK button to proceed with the next one.

The next event is RbL60

1.  In the edit field, type RbL60.

2. In the subdialog area, click on the Picture pop-up menu and select Open
File.

3. Locate the file RbL60 and click on Open.

4.  Click on the Event-Ending Response pop-up menu and choose Correct
Key.

5. Click on the Correct Response pop-up menu and choose the bB character,
since this letter is displayed backwards.

6.  Click on the OK button.

The event editor dialog will go away and come back immediately; click on the
Cancel button.

We’re now done with creating events. This is how the Experiment Editor
should look:

SuperLab User’s Guide



Creating the Trials

Experiment Editor - “tutorial.script”

Blocks Trials Stimuli/Events
%+ instructions

< FO

< LR30

< F180

< RbL6D

[
[
[

<
<
<

x 4

Remember to save your work so far.

As mentioned earlier, an event is the smallest unit of an experiment, and a trial
is a set of events. A trial may consist of any number of events. However, you
should avoid the common mistake and temptation of including all the events in
one trial.

In the case of this experiment, a trial will have only one event in it, and we will
give it the same name as an event, for simplicity’s sake. To create the five trials:

Hold down the Option key

. Trial N :
on your keyboard and click
on th.e New Trial buttop. [Juse for feedback only.
Holding down the Option Codes Dalues:

key tells SuperLab Pro to
keep asking for new trials
until you click the Cancel
button in the edit trial
dialog.

In the edit trial dialog, you will find a “Use for feedback only” check box
and a gray rectangle where code values would normally appear. Leave
them alone for now, we’ll come back to these two options in the next
chapter.

In the edit field, type “instructions.” Click on the OK button. The trial
editor dialog will go away and come back immediately.

Type “FO” and click on the OK button.
Type “LR30” and click on the OK button.
Type “F180” and click on the OK button.
Type “RbL60” and click on the OK button.
Click on the Cancel button.

That’s it. You have just created five trials. Remember to save your work.

Chapter 2 - SuperLab Basics 11



Creating a Block

The Linking
Process

Ablock is a set of trials, and may contain any number of them. There are no
restrictions nor conventions; feel free to organize your experiment however you
want. At least one block is required to run the experiment, so let’s go ahead and
create one:

= C(lick on the New Block button. A small dialog box will appear.
In the edit field, type “block 1.”
= C(lick on the OK button.

That’s it. You have just created a block. Save your work before proceeding
further. At this point, this is how the Experiment Editor window will appear:

Experiment Editor - “tutorial.script”
Blocks Trials Stimuli/Events
block 1 l#| [« instructions l#| [« instructions K+
< FO < FO
< LR30 < LR30
< F180 < F180
< RbL6D < RbL6D

<
<
<

x 4

We have now created all the elements needed for an experiment, but we are not
ready to run it yet. A block is a set of trials, and a trial is a set of events, but
how does SuperLab Pro know which trial contains what events?

Writing an experiment with SuperLab Pro is a two-step process. You have just
finished the first step, that of creating the blocks, trials, and events. The next
step is linking.

Linking tells SuperLab Pro which trials are contained in a block, and which
events are contained in a trial. The best way to explain links is probably to
proceed with an example right away. Keep in mind that, in this experiment, we
have only one event per trial.

1. Click on trial “instructions” to select it. Make sure you click on the name
itself, not the diamond (¢¥) preceding it.

2. In the list of events, there are hollow diamonds preceding every event
name. Click on the diamond preceding the “instructions” event. This
time, make sure you click on the diamond itself, not the event name. The
diamond should turn from hollow (£¥) to full (#).

3. Similarly, click on trial “FO” to select it.

4.  Click on the hollow diamond preceding the “F0” event. It should toggle
from hollow to full. Stop here for now.

SuperLab User’s Guide



Tip: holding down the
Option key works also with
trial-event links; it will
toggle all events.

You have just linked two trials to one event each. Trial “instructions” contains
the event “instructions,” and trial “F0” contains the event “F0.”

This approach to organizing an experiment using links provides flexibility. The
number of events or stimuli per trial does not have to be fixed; it can vary
within the same experiment. Linking also simplifies other user interface aspects
of SuperLab Pro. And finally, links allow the same event to be used in more
than one trial, thus reducing the memory requirements and the time it would
otherwise take you to set up the same event multiple times.

Before linking the remaining three trials, click on trial “instructions,” then click
on trial “F0,” and click on trial “instructions” back again. While doing this,
notice how SuperLab Pro automatically updates the diamonds in the list of
events to reflect which events are members of the selected trial.

We still have three trials to link:

1. Click on trial “LR30” to select it, then click on the hollow diamond
preceding the “LR30” event. It should toggle from hollow to full.

2. Click on trial “F180” to select it, then click on the hollow diamond
preceding the “F180” event.

3.  Similarly, on trial “RbL60” to select it, then click on the hollow diamond
preceding the “RbL60” event.

You have just completed linking all trials to all events. Remember to save your
work.

There is one last step required before we go ahead and run the experiment:
linking blocks to trials. At this point, we have only one block named “block 1,”
but SuperLab Pro does not know which trials are contained in it. The block-trial
links work similarly to trial-event links. In the case of this experiment, all trials
are included in “block 1.” Here is how to proceed:

1. Click on block “block 1” to select it.

2. Hold down the Option key on your keyboard, and click on any of the
diamonds preceding the trial names. Be careful to click on the diamond
itself, not the trial name.

Holding down the Option key while clicking on a diamond is a SuperLab Pro
shortcut that will toggle all diamonds in the list, not just the one you click on.

Congratulations! You have just completed the linking process, and you are now
ready to run your first experiment. Of course, you do remember to save your
work, don’t you?

Chapter 2 - SuperLab Basics 13



Running the
Experiment

Once the experiment is created, running it is straightforward. From the
Experiment menu (on the menu bar), choose Run. A dialog box comes up,
containing some options. These are discussed later in the “SuperLab Pro
Reference” chapter. But for now, leave these options unchanged. Click on the
Run button.

Next, SuperLab Pro will present you with a familiar “save file” box, asking for
the name of the results file. You can change the suggested file name if you like.
Click on the Save button when ready.

At this point, SuperLab Pro will hide the menu bar, open a window that covers
the entire screen, and start displaying the visual stimuli. You can cancel the
experiment at any time by pressing Command-period, that is, hold down the
Command key (#) then press period (.).

When done, SuperLab Pro saves the collected results to disk, removes the
window, and restores the menu bar.

Congratulations, you have just learned how to use SuperLab Pro. The next
chapter, “SuperLab Pro In Depth,” discusses additional topics. In particular,
you are strongly encouraged to read about SuperLab Pro’s codes before starting
to write your next experiment; they could save you quite some time.

As for the tutorial script you created while going through this chapter, do not
delete it yet. It will be used in the next chapter, “SuperLab Pro In Depth,” to
learn about other features.
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Chapter 3 - SuperLab Pro In Depth

This chapter discusses additional topics. It builds on the previous one by using
the same sample experiment and tutorial style whenever possible. Unlike the
previous chapter however, here you can read only the section of relevance to
your needs. For example, if you are interested in adding feedback to your
experiment, see the section “Adding Feedback” only.

Attaching Codes to Trials

Codes are intended to help you with the post-processing of data collected with
SuperLab Pro. The idea is to create codes and code values, and attach them to
trials. When you run the experiment, the collected data is saved as a plain text
file, with one line per response. Each line contains the trial number, event
number, answer from the subject, reaction time in milliseconds, an error code,
and the code values attached to the trial. In other words, your data is already
pre-coded!

The codes and code values you create could be any alphanumeric string. In the
following example, we will create two codes, Speed and Rotation. Speed has
three values, fast, medium, and slow. Rotation has 4 values, 0, 90, 180, and -90
(in degrees).

Codes Editor

Code Names Dalues

MNew

To create the codes and their values, select Code Editor from the Experiment
menu. A window similar to the above appears.

1.  Click on the New button to the left. A small dialog appears; type Speed



and then click on OK.

Similarly, click on the New button to the left again. Type Rotation and
then click on OK.

You have just created the codes.

In the Codes Editor window, click on the code Speed to select it. Hold
the Option key down on your keyboard, and click on the New button to
the right. A small dialog appears.

Type the first code value, fast, and click OK. Note that the small dialog
disappears and comes back right away. This is because you held down
the Option key before clicking on New. It is a standard SuperLab Pro
shortcut to speed data entry.

With the small dialog still up on the screen, type medium and click OK.
Type slow and click OK. The dialog box reappears. Click on the Cancel
button.

You have just created the code values for Speed.

In the Codes Editor window, click on the code Rotation to select it. Hold
the Option key down on your keyboard, and click on the New button to
the right. The small dialog appears.

Type 0 (zero) and click OK. The small dialog reappears. Type the other
code values the same way, i.e. type 90 and click OK, type 180 then click
OK, and type -90 then click OK. When done, click on the Cancel button.

You have just completed the creation of the codes and code values. While the
above seems like too many steps, it usually takes less than a minute to create all
the code and code values you need.

Now you are ready to “attach” these code values to trials. You can attach them
to either existing trials or to new ones. Let us take the example of a new trial:

1.

In the Experiment Editor window, click on the New Trial button. The
trial editor appears. Note how it contains all the codes just created.

Give the trial a name, say “demo trial.” Assuming this is a medium
speed trial with a picture rotation of 180, click on medium and 180. Click
on the OK button.
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Trial Name:

|demu trial |
[ Use for feedback only.

Codes Dalues:

Speed fast =law
Rotation u] Q0 =30

[

=

That’s it. You have just finished learning how to create and use codes. Itis a
good idea to plan in advance which codes you would like to use with an
experiment, but with SuperLab Pro you can create codes “on the fly” and attach
them to trials any time you want. You can even edit and rename the codes and
their values any time without having to reassign them to trials. If you try to
delete a code or a code value attached to a trial, SuperLab Pro will issue
warning. If you confirm the warning message and delete, all reference to the
deleted code are automatically removed from all trials.

Adding Feedback

SuperLab Pro allows you to add feedback in one of three cases: the subject’s
response is correct, the subject’s response is incorrect, or there is no response
within a time period you specify. A feedback can be auditory, visual, or both.
It is presented to the subject only once, and then the experiment proceeds with
the next event.

Adding feedbacks to your experiment is easy. The steps involved are similar in
many ways to setting up trials. In fact, a feedback is an entity Adding
feedbacks to your experiment is easy. The steps involved are similar in many
ways to setting up trials. In fact, a feedback is an entity very similar to trials.
Here is how to go about adding feedbacks:

1. In the Experiment Editor, click on the New Event button. Create as many
events as you will need to present feedbacks.

2. Click on the New Trial button. The trial editor comes up. Init, click on
the check box “Use for feedback only” and give your feedback a name,
e.g. Good feed or Bad feed. When you click on the check box, the size of
the trial editor becomes smaller.
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Trial Name:
-l:ancel
Good Feed

[ Use for feedback only.

Click on the OK button. In the Experiment Editor, the feedback name is
preceded with a delta (£) instead of the hollow diamond (<). The delta
indicates a feedback.

3. Link the necessary events to the feedback, i.e. tell SuperLab Pro which
events are included in the feedback you have just created. The linking
process should now be a familiar step; it is identical to how you would
link trials to events.

4. The linking process completes the creation of the feedbacks. To add a
feedback to an event, double-click on the event. The event editor comes
up.

5. Click on the feedback button; a subdialog appears. It contains three pop-
up menus. If you click on either one of the three, you will see all the

feedbacks you have already created. Select the one(s) you want and click
on OK.

Please note that an event that is itself part of a feedback cannot have feedbacks;
if a feedback is set, it will simply be ignored.
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Chapter 4 - On Timing And Input

[]

This chapter discusses the crucial issue of timing, how SuperLab Pro does it,
what you can do to help improve it, and other details related to using a
particular input device or timer. Other topics that affect the accuracy of timing
are also discussed here.

At Cedrus, we designed SuperLab Pro to be friendly yet powerful, and we are
trying to keep its manual as clear as possible, eliminating the unnecessary
“computerese” whenever possible. Unfortunately, when discussing timing, we
have to introduce some computer concepts as well as some Macintosh-specific
information.

If you are serious about timing, it is suggested you read this chapter in its
entirety. No single section in it will give you the whole picture.

Timing Options

The TickCount Timer

SuperLab Pro provides three options to perform timing: TickCount, Time
Manager 1 and Time Manager 2.

This is the Macintosh’s “standard” timer; it has been around since the very first
Macintosh 128K introduced in January 1984. It gets incremented 60 times a
second, thus yielding an accuracy of +16.67 milliseconds, at least in theory. In
practice, Inside Macintosh, Apple Computer’s technical reference (volume 1,
page 260), warns not to “...rely on the tick count being exact; it will usually be
accurate to within one tick, but may be off by more than that.”

Since the days Apple warned about TickCount inaccuracy, things have gotten
worse. We now have System 7 and multitasking, where several applications
can be running simultaneously. We also have startup programs, better known
as INITs or system extensions, that sometimes run constantly in the
background.

If, for whatever reason, you want to or must use the TickCount timer, there are
things you can do to help improve accuracy. When you are ready to run the
experiment, make sure SuperLab Pro is the only application running. Close all



Time Manager 1
Time Manager 2

Recommended Timer

desk accessories. Use the Control Panel to disable or turn off as many INITs as
you can live without; if they can not be disabled, remove them from your
System Folder then restart your Mac. Examples of INITs that are always
running in the background are: screen savers (e.g. PYRO!, Moire, After Dark),
SuperClock, some screen capture programs, some “cute” programs (e.g.
Eyeballs, Big Foot), etc. If in doubt, disable the INIT or remove it.

With the introduction of the Macintosh II and the Macintosh SE in March 1987,
Apple also released a new version of the system software. The new release 6.00
contained the Time Manager, a set of functions programmers could use to
perform some timing. Unfortunately, the Time Manager was inadequate for
SuperLab Pro; it did not do what was needed. Thanks to the advent of
multimedia applications (which require accurate timing to synchronize video
and audio), Apple introduced the Revised Time Manager in System 6.03, and
the Extended Time Manager with System 7.0.

The Time Manager timers built into SuperLab Pro are “clean,” meaning that
they are totally device independent, and work with any Macintosh equipped
with System 6.04 or a later version. The only difference between SuperLab
Pro’s Time Manager 1 and 2 is accuracy and range: Time Manager 1 is accurate
to + 1 ms with a range of about a day, while Time Manager 2 is accurate to + 20
ps with a range of about 34 minutes. The described ranges are per event, not for
the entire experiment.

Without any doubt, the recommended timers are Time Manager 1 or 2. If for

some reason you are not using System 6.04 yet (or a later version), it is worth-
while upgrading your system software. Contact your Apple dealer to obtain

the upgrade.

You may wonder why anybody would want to use Time Manager 1 (+ 1 ms) if
Time Manager 2 (+ 20 ps) is available. The reason is simple: the system
software has to update Time Manager 2 fifty times more often then Time
Manager 1. Every processor cycle put into updating the timer is a cycle taken
away from the presentation of your stimulus. In other words, presenting your
stimulus will be slightly slower when using Time Manager 2. In normal
situations, this is OK. But if you are placing a lot of demand on SuperLab Pro
and the Mac, especially with long auditory stimuli or complex pictures, you
may want to revert to Time Manager 1.
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Input Options

[]

Generic Keyboard

ADB Keyboard

8255-based Card

Deciding which input option to use is as important as the choice of timer, since
it is the combination of both that determines accuracy. Several options are
provided: Generic Keyboard, ADB Keyboard, 8255-based Card, NB-MIO-16
Card, Serial Ports CTS, Cedrus RB-400 Response Box, Cedrus RB-600 Response
Box, and Microphone. Physically, Generic Keyboard and ADB Keyboard are
the same; only the software used to read them is different.

A current limitation is that SuperLab Pro cannot check for input from the
subject while a stimulus is being drawn. This will be remedied in a future
release of the software.

This is basically any Macintosh keyboard, including that of the Mac Plus. The
timing resolution is one tick count, or £16.67 milliseconds. The Generic
Keyboard module may be alright for teaching purposes, but it is not
recommended for studies requiring accurate reaction time measurements.

The Generic Keyboard allows up to 46 responses, each having from 1 to 7
characters.

ADB stands for Apple Desktop Bus, first introduced with the Mac II and the
Mac SE in 1987. Theoretically, it allows up to 15 low speed input-only devices
to be connected to the Macintosh. In practice, due to electrical limitations, no
more than three devices are recommended. “Low speed” is of course a relative
term; an ADB device is expected to respond to the Mac in 260 microseconds or
less. The nominal response time for both the Apple Standard Keyboard and the
Apple Extended Keyboard is 200 microseconds.

The Macintosh system software polls the keyboard every 10 to 14 milliseconds.
SuperLab Pro provides its own driver that polls the keyboard as fast as the
system software will allow; on a Mac Ilci, the polling happens once every 4
milliseconds

For technical reasons related to power management, the ADB Keyboard driver
will not work on the PowerBooks. The Generic Keyboard allows up to 47
responses, each having from 1 to 7 characters.

This input module supports the National Instruments NB-DIO-24, LabLC, and
Lab-NB cards. These are cards with 24 lines that may be used for either input or
output. SuperLab Pro supports up to 8 lines for input and 8 lines for output.
For input, the card is accessed very quickly, in 50 microseconds or less.
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NB-MIO-16 Card

Serial Ports CTS
RB-200M Response
Box

RB Series
Response Pads

If you chose this input module and SuperLab Pro gives you an error when you
run the experiment, make sure you have the correct slot number. The slot
number is 0 t0 9, or A to E. Do NOT use the slot number that the National
Instruments” NIDAQ Control Panel gives you! NIDAQ uses its own numbering
scheme that has nothing to do with the physical slot number.

The 8255-based Card module allows up to 8 responses. The analog i/o features
of the Lab-NB and LabLC cards are not supported in SuperLab Pro.

Please see the section “Debouncing Time” below.

SuperLab Pro supports the National Instruments NB-MIO-16 card. Itis a card
with 8 lines that may be used for either input or output. SuperLab Pro supports
up to 4 lines for input and 4 lines for output. For input, the card is accessed
very quickly, in 50 microseconds or less.

The NB-MIO-16 Card module allows up to 4 responses. The analog i/o features
of the Lab-NB and LabLC cards are not supported in SuperLab Pro.

Please read the previous section, 8255-based Card, for additional information
on choosing a slot number.

Please see the section “Debouncing Time” below.

SuperLab Pro supports input from the serial ports using the CTS (Clear-to-
Send) handshake line. This allows you to connect various input devices to the
serial port without the need to encode the data serially and without having to
purchase an i/o card. The main disadvantage of this input module is that only
one input is possible per serial port, so one is limited to a maximum of two
inputs.

To use this input module, make sure that AppleTalk is turned off. You can turn
it off by selecting “Chooser” from the Apple menu.

Cedrus manufactures the RB-200M, a high quality 2-button response box that
connects to the two serial ports and uses this input module. Visit our Web site
(http:/ /www.cedrus.com) or contact Cedrus for more information.

Please see the section “Debouncing Time” below.

SuperLab Pro supports Cedrus’ RB Series response pads, the RB-400, RB-410,
RB-420, RB-600, RB-610, and RB-620. They are high quality, microprocessor-
controlled response pads. The RB-400, RB-410, and RB-420 have four
pushbuttons and the RB-600, RB-610, and RB-620 have six. They connect to the
computer using a serial port. The microprocessor in these response boxes
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Microphone

Lumina Response
Pads for fMRI

automatically takes care of switch debouncing. Visit the Cedrus web site
(http://www.cedrus.com /responsepads) or contact us for more information.

The microprocessor in these response boxes automatically takes care of switch
debouncing. Please see the section “Debouncing Time” below for more
information.

If you decide to connect the response box to the printer port instead of the
modem port, make sure that AppleTalk is turned off. You can turn it off by
selecting “Chooser” from the Apple menu.

SuperLab Pro supports the built-in microphone. This allows you to have voice
key input without requiring any additional hardware. The Microphone module
will record the reaction time but not the spoken response itself. It also lets you
set a threshold, the sound level above which sound is considered a valid
response.

The Microphone module will also let you accept input from the keyboard. The
accuracy of this input is the same as that of Generic Keyboard: +16.67
milliseconds. Keyboard input was added to the Microphone module to allow
the experimenter to “pace” trials and do things like “press any key to proceed”
or allow time to write down the subject’s response.

It is possible to use the Microphone module on older Macs that do have a built-
in microphone jack. You will need a product called MacRecorder which plugs
into a serial port.

If you run into difficulty using the Microphone input module, try recording and
playing back a sample sound using the Sound control panel. If it doesn’t work
in the Sound control panel, it won’t work in SuperLab Pro.

A note of caution is in order for users of PowerBooks with a built-in
microphone. On many such models, the Mac operating system will shut down
the hard disk every time SuperLab Pro tries to get voice key input from the
subject! This is intended as a feature by Apple: the idea is that the vibration of
the hard disk is transmitted through the case to the microphone and thus
reduces the sound quality of the recorded sound. If your PowerBook exhibits
such behavior, you can get around it by plugging an external microphone.

Please see the Frequently Asked Questions section in the last chapter for
information about using audio input and audio output at the same time.

SuperLab Pro supports Cedrus’ Lumina response pad system especially
designed for fMRI. This is a microprocessor-controlled system that includes
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two pads with two keys each and is accurate to one millisecond. Lumina
connects to the computer’s serial ports with speeds up to 110K baud. Visit
Cedrus' web site (http://www.cedrus.com/lumina) or contact us for more
information.

Debouncing Time If you decide to build your own response box, take particular care about the
choice of pushbuttons the subject is going to use. When pressed, almost every
pushbutton “bounces,” that is, closes the electronic contact and reopens it
several times for a short period. This is usually too quick to be noticeable but it
does happen. The better the switch quality, the shorter the bouncing period will
be.

To get around this problem, a number of input modules supplied with
SuperLab Pro let you set a “debouncing time,” a period of time during which all
input from the subject will be ignored after a pushbutton is pressed. To
illustrate the problem, set the debouncing time to zero and and run an
experiment. In the collected data file, chances are good you will see several
records (lines) for each incorrect response. Keep increasing the debouncing
time until you no longer see multiple records per response.

Please note that the debouncing time is “waited out” only when the subject
responds incorrectly and the input module has to look for another response for
the same event. If the subject responds correctly and SuperLab Pro proceeds to
the next event, the debouncing period is ignored.

The Cedrus RB-400 and RB-600 response boxes take care of the switch
debouncing themselves. After the status of a pushbutton changes and the
information is sent to the serial port, the RB-400 and RB-600 introduce a very
brief debouncing period, under 1 millisecond.

Recommended The recommended input module depends mostly on the available hardware.
Input Module On older Macs equipped with the Apple Desktop Bus, ADB’s 4 millisecond
resolution is satisfactory for most people but is not an option on PowerBooks or
more recent Macs. On those models, a response pad is highly recommended if
reaction time resolution is important.

How a Visual Stimulus is Presented

Although this section comes after the discussion of timing and input, it is
equally important. In fact, to complete the discussion on timing, you must
know when SuperLab Pro starts to measure the reaction time, and that depends
on the type of Macintosh you are using.
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Video Monitors
Primer

The section provides a quick introduction to video monitors technology. It will
help you understand why, even though SuperLab Pro’s timers are accurate to
within a millisecond, a visual stimulus is not presented within a millisecond.
Even if you feel you know enough about the subject, it is a good idea to go
through it quickly to ensure the terminology is consistent in subsequent
sections.

Video monitors used in today’s computers are a quantum leap improvement
over storage tube displays so common in the sixties and seventies. A monitor
represents its information using a “matrix” of pixels that can be turned on or off.
The matrix is often referred to as a raster. The word pixel is an abbreviation of
“PICture ELement,” the smallest unit of information that can be displayed by a
video monitor — basically a dot on the screen.

The illustration above shows a magnified raster. All pixels in it are turned off
except for a few cleverly aligned to form the letters a, b, and ¢, and a line. When
a computer is instructed to draw a line from point A to point B, it has to
perform a series of calculations to decide which pixels to turn on. This is
referred to as rasterization.

From the inside, a video monitor contains a “gun” shooting electrons at the
screen. The inside of the screen is coated with phosphorous material. When hit
by the electrons, the phosphorous coating produces light, and a pixel is seen
turned on. By turning enough pixels on, a picture and/or text forms on the
screen.

This approach to information display provides great flexibility. But there is one
catch: if the gun inside the monitor stops shooting electrons at the pixel location
on the screen, the phosphorous coating will no longer light. To get around this,
a computer instructs the electron gun to shoot at a given location on the screen
several times a second, typically 30 to 120 times per second. This operation is
very important, and is known as refreshing, or video refresh.

Video refreshing raises yet another issue: how does the computer know which
pixels are supposed to be on? As you are well aware, every computer comes
with memory, the famous RAM you keep hearing about. To accommodate
video refreshing, the computer must have video memory. In some cases, video
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memory is physically different from the main memory. In others, the computer
simply sets aside a portion of the main memory. But in all cases, the status of a
pixel on the screen is always remembered in memory.

When refreshing occurs, the electron gun goes from top to bottom, from one
side of the screen to the other. Because of this, the electron gun is often referred
to as the refresh beam or refresh line. One scan from top to bottom is known as the
refresh cycle. More cycles per second are better because they result in less
flicker and a better picture. The number of cycles per second is often expressed
in Hz (pronounced Hertz). For example, a 60 Hz video monitor has its image
refreshed sixty times per second.

A bit is the smallest unit of information. It has two states, 0 or 1. For black and
white monitors, only one bit per pixel is needed. For color monitors, we need
more bits per pixels, depending on the maximum number of colors that can be
displayed at any one time. For example, a 256 color monitor requires 8 bits for
each pixel.

Color brings with it an extra layer of complexity. For example, in the case of the
256 color monitor, the software can choose which 256 colors to use out of a
palette of 16 million colors. To keep track of the chosen colors, the computer
maintains a color table. Each entry in the table stores in index to the desired
color. By altering the entries in the color table, one can select any 256 colors out
of the 16 million range. Of course, there are cases when the computer does not
need a color table, e.g. if you have either a black and white monitor or a video
card capable of displaying all 16 million colors at the same time.

The problem with presenting a visual stimulus is speed. Based on the
discussion above, the best one can do is present a stimulus within one refresh
cycle. But if a picture takes a long time to draw, it will be many refresh cycles
before the computer is done drawing it. To help reduce drawing time to just
one cycle, SuperLab Pro provides two features: ‘Instant Switching,” and refresh
line synchronization.

works only on Macintosh models with an indexed color table, that is, a Mac in
16 or 256 color mode. As mentioned earlier, one can select any 256 colors out of
the 16 million range simply by altering the entries in the color table. This is how
Instant Switching works:

1.  All the entries in the color table are saved.

2. All the entries in the color table are set to the background color, usually
white or black.

3. The picture is drawn. Since all the entries in the color table are set to the
background color, the subject will not see the picture while it is being
drawn.
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4. When the picture drawing is completed, SuperLab Pro waits until the
refresh line reaches the top of the screen. This is refresh line
synchronization.

5. Once the refresh line is at the top of the screen, SuperLab Pro restores
into the color table all the entries saved earlier in Step 1.

6. Measurement of reaction time begins.

Unfortunately, Instant Switching cannot be used unless a color table is
available. This means it can neither be used on black and white Macs, nor in 24-
bit (16 million) color mode. In cases when it is not possible to use Instant
Switching, this is how SuperLab Pro proceeds:

1. Refresh line synchronization is still used. That is, SuperLab Pro waits
until the refresh line reaches the top of the screen.

2. SuperLab Pro starts to draw the picture.

3. Assoon as drawing the picture is complete, measurement of reaction
time begins.

Please read on for more information on running experiments on a PowerBook,
using more than 256 colors, and gamma tables.

Using SuperLab Pro to run experiments on Apple’s PowerBook models presents
its own challenges. The liquid crystal displays (LCD) used on these models use
a technology fundamentally different from the one used on desktop video
models.

For the Apple Portable and all PowerBook models running in black and white
mode, it is not possible to use Instant Switching, for reasons described above.
For the PowerBook 160 and 180 models, it is not possible to use Instant
Switching either, even in 16 color mode, the color table used in these models is
fixed, not indexed, and it is not possible for SuperLab Pro or any other software
to alter it. But it is possible to use Instant Switching on an external monitor
attached to the built-in video port of the 160, 165¢, or 180.

In general, using an LCD display to present visual stimuli is not recommended,
due to the high persistence levels.
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Chapter 5 - SuperLab Pro Reference

This chapter forms a reference to all of SuperLab Pro menus and editors. Let’s
start with the editors and dialogs, in the order you would use to build and run

an experiment.

The Responses Editor

Tip: if you hold down the
Option key while clicking
on New, SuperlLab Pro will
keep prompting for new
responses until you click
Cancel. This option-New
shortcut works with all
SuperlLab Pro editors.

A response, in the context of SuperLab Pro, is a possible answer to a stimulus.
For example, an experiment may accept only one of two answers, yes or no.

SuperLab Pro allows you to define interactively the number of responses you
can have, as well as what characters constitute each response. You can define

up to 46 responses, each having from 1 to 7 characters.

The Responses Editor allows you to add, edit, and
delete responses for the experiment. To select a
response, simply click on it.

= Toadd a new response, click on the New
button. If a response happens to be already
selected, the new response is inserted just
before the selected one; otherwise, the new
response is appended at the end of the list.

[J Responses Editor

Responses
nN K
¥
J L E
fioiaia
| [ New
L vy

To edit an existing response, select it then click the Edit button, or double-

click on the response itself. Note that the responses are case sensitive,
meaning that SuperLab Pro distinguishes between upper and lower letters.

= To delete a selected response, click the Delete button, press the Delete key
on your keyboard, or select Clear from the Edit menu.

If you try to delete a response referred to by an event elsewhere in the
experiment, SuperLab Pro will warn you so and confirm whether you want to

go ahead.

The Codes Editor

SuperLab Pro codes are of no use for the purpose of administering the



Tip: if you hold down the
Option key while clicking
on New, SuperlLab Pro will
keep prompting for new
codes or code values until
you click Cancel.

experiment itself; they come into play later, once you are through with the
testing. The idea is to be able to attach one or more codes to each trial, and use
them later in the analysis of the results.

A code can have a number of values; for example, a code named Difficulty may
have one of three values, easy, medium, or hard. Another code named Cue can
have just two values, valid or invalid.

Taking advantage of codes is a three-step process. One, use the Codes Editor to
define all the codes and their values. Two, double-click on a trial in the
Experiment Editor; this will bring up a dialog in which all the codes you have
already defined will appear. And three, simply point and click to associate the
code values with the trial. Later, when you administer your experiment, these
code values will appear in the results file that SuperLab Pro saves.

The following picture illustrates what the Codes Editor looks like. In it, we
have defined the two codes mentioned above, Difficulty and Cue. The codes
are listed on the left, their values on the right. Note that, on the right side, the
Edit and Delete buttons are “dimmed,” they are not accessible. This is because
no code value happens to be selected. Click on a value and the buttons will
automatically be reactivated.

= To create a new code,

O Codes Editor

click on the New Code Names lalues
butt the left.
utton on the fe Difficulty TEEELE iy
= To create a new code Cue medium —
HEEY
value, select the hard
desired code then Golete
click on the Ngw New = | (New
button to the right. L y

To view different

code values, simply click on the code name itself. In the illustration above,
for example, clicking on the code Cue will automatically list its values on
the right side.

To delete a selected code, click the Delete button on the left, press the
Delete key on your keyboard, or select Clear from the Edit menu. This will
also delete all the values associated with it.

To edit an existing code, select it, then click the Edit button on the left, or
double-click on the code name itself.

To delete a selected value, click the Delete button on the right. Do not use
the Delete key on your keyboard or Clear from the Edit menu, since this
will delete the selected code and all its values, not just the selected value.

To edit an existing value, select it, then click the Edit button on the right, or
double-click on the value name itself.
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If you try to delete a code value already referred to by a trial elsewhere in the
experiment, SuperLab Pro will warn you so and confirm whether you want to
go ahead.

You can create up to 20 codes, and each code can have up to 8 values. The code
name may contain from 1 to 11 characters. A code value can contain from 1 to 7
characters.

For details on how to associate the code values with a trial, see the section
“Attaching Codes to Trials” in chapter 3.

The Experiment Editor

The Experiment Editor is where most of the work is done in SuperLab Pro. In
it, you get to setup your blocks, trials, and events.

An event, in the context of SuperLab Pro, can be a visual stimulus, an auditory
stimulus, an inter-stimulus interval (ISI), or digital output via a National
Instruments card.

For simple experiments, a trial usually consists of one event. For more involved
experiments, a trial could consist of any number of events; however, no matter
how many events per trial you have, by convention only one event per trial
accepts a response from the subject.

A block consists of any number of trials.

Exdperiment Editor - “edample.script™

Blocks Trials Stimuli/Events
block 1 |4+ |+ instructions |4+ |+ instructions i
< FO < FO
< LR30 < LR30
<+ F180
< RbL60D < RbL60D
= = =
h "y

These three fundamental elements, events, trials, and blocks, are all grouped
into one window illustrated above, the Experiment Editor. This section
assumes you have read chapter 2, “SuperLab Pro Basics.” It does not try to re-
explain the concept of linking and other miscellaneous topics.

= To create a block, trial, or event, click on the New Block, New Trial, or
New Event button respectively. If you hold the Option key down while
clicking on the mouse button, SuperLab Pro will let you enter
automatically new blocks, trials, or events until you click on the Cancel
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Editing an Event

button.

If no item is selected when you click on a New button, the new one is
appended at the end. If one was already selected, the new one is

inserted right before the selected one. For example, suppose you want to
create an event named What-A-Day. In the above picture of the
Experiment Editor, after clicking on the New Event button and creating
What-A-Day, the new event will be inserted between the events LR30 and
F180.

You can select more than one item at a time. For example, you can select 5
blocks and copy them to the Clipboard at the same time. To select
contiguous items, click on the first one to select it, hold the Shift key down
on the keyboard, then click on the last item you want selected. All items in
between will get selected too.

To select disjoint items (items that are not next to each other), select the
first one, hold the Command (3€) key down on the keyboard and click on
the other items you want to select.

You cannot select an event and a trial at the same time, or a trial and a
block. You can select multiple items only from the same type.

To deselect an item, hold the Command (3) key down on the keyboard
and click on the item.

To delete a block, trial, or event, click on it to select, then press the Delete
key on the keyboard, or choose Clear from the Edit menu. Since the
current version of SuperLab Pro does not implement the Undo function, be
careful when deleting.

If you are deleting an item referred to elsewhere in the experiment (i.e.
cross-referenced), SuperLab Pro will tell you so and confirm whether you
want to go ahead. Examples of items that can be cross-referenced: an
event linked to a trial or a trial linked to a block.

To edit an existing block, trial, or event, double-click on it.

To cut, copy, or paste a block, trial, or event, see the upcoming section,
“The Edit Menu.”

The title bar shows the name of the experiment. If this is a new one, the name
will be “Untitled.script.”

Creating a new block or editing an existing one is a simple matter of giving it a
name. Creating a new trial or a new feedback is described in the section
“Attaching Codes to Trials” in chapter 3. The rest of this section details the
event editor.

In SuperLab Pro, an event is the smallest unit of an experiment. The event
editor packs a number of functions into one dialog. You can think of it as
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divided into two parts: the first one is a subdialog area; its contents change
depending on the event type. More on that a little later.

To edit an existing event, double-click on it.

Subdialog
Area

Time limit: III ms :

(< Accepts user input

End event | only after cri n response

Event-Ending Response:
Correct Response:

(File Info] [Feedback...] [ o0k ]| [cancel ]

The second part, the rest of the dialog, is where you control how input is
accepted from the subject. Going from top to bottom:

= Type the event name in the edit field. It must be unique: no two events
may have the same name.

= Select the event type using the pop-up menu right under the edit field.
Currently, four types are implemented: visual stimulus, auditory stimulus,
inter-stimulus interval (ISI), and digital output. The contents of the
subdialog area change depending on the event type you choose from this
menu.

Next, you find a Time Limit edit field. This is optional; its use depends on
how you choose to terminate the event, described below. The time limit
you specify is in milliseconds.

The “Accepts user input” check box determines whether input is accepted
at all from the subject. If you turn it off, SuperLab Pro will present the
event and proceed with the next one.

The next pop-up menu controls how the event is terminated. You can end
an event only after a criterion response from the subject; the experiment
does not proceed until the subject responds. You can end an event after a
criterion response or a time limit is exceeded, whichever happens first. Or
you can terminate an event only after a time limit is exceeded, even if the
subject responds correctly.

The Event-Ending Response pop-up menu lets you choose what you
consider to be the criterion response. Choices are Any Key or Correct Key.

If the criterion response is Correct Key, the Correct Response pop-up menu
lets you choose which key that is. The first item is <None>. The
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The “Visual”
Subdialog

remaining items are the responses you defined earlier using the Responses
Editor. If you are using a National Instruments card instead of the
keyboard, the menu items will be Button 1, Button 2, .... Button 8.

The Feedback button allows you to provide feedback to the subject. Before
doing so, the feedbacks must have already been created. See the section

“Adding Feedback” in chapter 3.

Assuming you have created three Feedback to Subject, Based on the Response:
feedbacks called Good Feed, Bad If correct, feedback is [<No Feedback> |
Feed, and No Feed, clicking on the If incorrect, feedback is [<No Feedback> |
Feedback button brings up a small If no response is obtained
dialog box. It contains three pop-up within ms,
menus. The first item in each of the LCLDILIEYE] ~<No Feedback> (I
menus is <No Feedback>. The Good Feed

Bad Feed

remaining items are the feedbacks

created earlier. For example, to
provide a feedback when no response

is obtained from the subject within 4 seconds, click on the bottom pop-up menu,
select the proper feedback, and type 4000 in the edit field. Correct and incorrect

feedbacks work similarly.

Some event types, such as visual and auditory stimuli, require that an external
picture or sound file be loaded. Once loaded, the File Info button brings up an
information dialog describing the file name, location on disk, and size.

SuperLab Pro does not have any drawing tools built into it. Instead, you use
one of the many graphic packages available on the market, save the visual
stimulus you have drawn as a PICT file, and then load it within SuperLab Pro.
Once loaded, you can control the picture’s position on the screen and how it is
presented. The visual stimulus could be anything: text, graphics, black and

white, color, hand drawn, or digitized.

The Visual stimulus portion of the event editor dialog has
two parts: a pop-up menu and a “mini-view.” The pop-
up menu is where you open the PICT file and control its
position on the screen. Once the file is open, a mini-view
(also called thumbnail view) is displayed. In the screen

snapshot to the right, the mini-view shows a text stimulus.

The stimulus is scaled down if necessary to fit in the mini-
view area.

Open File...

Picturel

GGNNN
NTGNN

Presents the “get file” box. Choose the file you want, then click on the Open
button. If the file you saved earlier in your graphics program does not appear
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Open File...
Preview Picture

Edit Size...
Edit Position...
Set Presentation...

in the get file box, it may be because you forgot to save it as PICT or PICT2.
Almost all drawing programs on the Mac support the PICT standard.
However, most save the picture in a format particular to the program itself,
unless you specifically ask it to save as PICT.

Picture Preview
After altering the picture’s size or position, you can choose Preview Picture
from the pop-up menu to see how the picture will look exactly when presented
to the subject. When previewing, SuperLab Pro will show in the bottom left
corner of the screen the time it took to display the picture, in milliseconds. Click
the mouse button, or press any key on the keyboard to return to the events
editor.

Edit Size...

Brings up a small editor where you can set the picture’s size. At the top, the
dimensions of the picture appear in pixels, and will change automatically as
you edit the size. SuperLab Pro gives you three options:

= “Original picture frame” will retain the picture’s original dimensions, as
stored in the PICT file when you saved it. In most graphic applications,
the picture frame is not the entire page, but rather is large enough to
contain all the picture elements.

“Scale to fit display” will scale the picture appropriately to fit the entire
screen.

“My own frame size” lets you type in the exact dimensions you want to
give the picture, in pixels. The dimensions of the picture at the top of the
dialog automatically change from static to edit fields.

Edit Position...
Brings up a small editor where you can set the picture’s position. SuperLab Pro
normally centers a picture on the screen both horizontally and vertically; you
can disable one or both centering options and specify instead where you want
the picture to be. At the top of the dialog, the position of the picture is
displayed, in pixels, measured from the center of the screen to the center of the
picture.

When you disable one or both centering options by clicking on the corres-
ponding check box, the picture position displayed will change to edit fields.
Simply enter the position.

Set Presentation...

The Set Presentation menu item brings up a small dialog offering other features
you can control.
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The “Auditory”
Subdialog

If the ”Erase screen before Visual $timulus Presentation:

presenting stimulus" CheCk bOX is [ Erase screen before presenting stimulus
checked, the screen will be erased X Use ‘Instant Switching’ to mask drawing
before the stimulus is presented If []Keep stimulus invisible (switched out)
unchecked, this screen will not be Wait[150 | ms Before Starting to Draw
erased, allowing you to overlay
multiple visual stimuli on the

screen at the same time.

If the “Use “Instant Switching’ to mask drawing” check box is checked,
Instant Switching will be used during the stimulus presentation. See the
chapter “On Timing And Input” for a description of Instant Switching.

Available only if “Instant Switching” is used. Enables you to keep the
color table switched out while stimuli are being presented. Very useful on
color Macs if presenting a stimulus consisting of more than one PICT file at
the same time. See note below.

The “Wait 150 ms before starting to draw” feature allows you to add a lead
time before a picture is drawn. Notice the check mark (+') button on the
right; if you click on it, the text will toggle to “Wait 150 ms minus drawing
time.” In that case, SuperLab Pro figures out how long the picture takes to
draw, and than waits a total of 150 milliseconds, including the picture
drawing time. If the picture takes longer than 150 milliseconds to draw,
you will get a warning at run-time if you run the experiment in debug
mode.

Note that the 150 milliseconds figure was used here as an example only.
You can set the time to any value you want.

The combination of features in the Set Presentation dialog is handy when trying
to present a trial that has multiple events/stimuli in it.

SuperLab Pro supports all variations of System 7 sound Mode: synch ©
files. SoundEdit is also supported but its use is no longer  Rate: 22000z %
i Volume: 3 &

recommended. Once the file is loaded, you can control
the mode (synchronous or not). The volume and rate
controls are present for historical reasons only and will be

removed in an upcoming version.

To load the sound file, click on the File icon. The “get file” box appears;
choose the file you want then click on the Open button. If the file you
saved earlier in your sound editing software does not appear in the get file
box, it may be because you forgot to save it as a System 7 or SoundEdit
file.

To play or preview a sound file, click on the Play icon.

To toggle the play mode between synchronous and asynchronous, click on
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The “Digital
Output” Subdialog

the check mark (+') button. When set to “Asynch,” SuperLab Pro will play
the sound asynchronously, meaning it will proceed with the next event or
start looking for input from the subject while the auditory stimulus is still
being played. If set to Sync, SuperLab Pro waits till the stimulus is done
playing before anything else can happen. This feature may not work well
on Macintosh models not equipped with the Apple Sound Chip. All Mac
I models have the ASC. Others may or may not, check your Owner’s
Guide.

We strongly recommend the use of System 7 sound files over SoundEdit for
several reasons. One, they can be mono, stereo, compressed, or 16-bit, whereas
SuperLab Pro supports only mono SoundEdit files. And two, you can hear a
System 7 sound file simply by double-clicking on it in the Finder. With
SoundEdit files, you will have to open the file from within SuperLab Pro or
SoundEdit to be able to hear it.

Be careful not to use MACE3 compression on stereo sounds. The result will be
aweful! In addition, presenting sound while using the Microphone input
module may cause some problems on some lower end Macintosh models. See
the Frequently Asked Questions section in the last chapter for more details.

SuperLab Pro supports digital output on four different
National Instruments models: the NB-DIO-24, LabLC,

Lab-NB, and NB-MIO-16. Duration:[1000_us
: I.P.1.: us
The first three models have 24 i/0 lines divided into three Repeat D times

ports, A, B, and C. Port A is used for input (see the
chapter “On Timing And Input”). Port B, containing 8 lines, is used for digital
output.

The NB-MIO-16 contains two ports, each with 4 lines. The first is used for input
and the second for output.

To choose the lines on which pulses will be going out, type it in the edit field.
Valid values are 0 (no lines) to 255 (all lines at the same time). The table below
will help you select the values appropriate for each line:

For line # The value is
0 1
1 2
2 4
3 8
4 16
5 32
6

64
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7 128

To output pulses on more than one line at the same time, simply add the
matching values. For example, to output a pulse on lines 3 and 6, type the value
72 (8+64).

= To set the pulse’s duration, simply type it in. SuperLab Pro will accept all
values, but will round them to the nearest 20 ps (see note below).

= LP.Lis the inter-pulse interval. It is meaningful only if you are generating
a stream of pulses. As with pulse duration, values will be rounded to the
nearest 20 ps.

In the last edit field, type how many pulses are generated for the event.

Click on the Test button to generate a sample output pulse. If SuperLab
Pro gives you an error, make sure you have the correct slot number. The
slot number is 0 t0 9, or A to E. Do NOT use the slot number that the
National Instruments” NIDAQ Control Panel gives you! NIDAQ uses its
own numbering scheme that has nothing to do with the physical slot
number.

The Digital Output module in SuperLab Pro uses Time Manager 2 to time the
duration of the pulse and the I.P.I. Given the accuracy of that timer (+20 ps), it
is recommended that the pulse and I.P.I. durations be at least 100 s long.

The File Menu

New N
Open... #0
Close #I
Save ¥S
Save As »
Page Setup...

Frind.. et
Quit *®0

The File menu allows you to perform all file-related functions, such as creating
a new experiment script, opening an existing one, saving, and printing. Keep in
mind that only one experiment may be loaded at any one time.

The following describes items in the File menu.

Creates a new experiment and automatically opens the Experiment Editor. If
there is an experiment currently loaded and changes made to it have not been
saved, SuperLab Pro will remind you to save the changes.

Open...

Presents you with the standard “get file” box. Click the Open button to load the
script, or Cancel. If there is an experiment currently loaded and changes made
to it have not been saved, SuperLab Pro will remind you to save the changes.

Loading an experiment’s script takes place in two stages. First, the script itself
is read, translated (parsed), and checked for errors. Next, all the picture and
sound files described in the script get loaded into memory. If, for one reason or
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< a SuperLab™ document...
a Microsoft Excel text file...
a Macllirite 11 text file...

Customize This Menu...

another, SuperLab Pro cannot find a given file, it will present you with the
standard get file box again and ask you to locate it.

Close

Closes the window if the frontmost window is the Codes or Responses Editor.

If the frontmost window is the Experiment Editor, the experiment is closed; if
you have made changes that are not saved yet, SuperLab Pro will remind you to
save the changes.

Save

Saves changes you made to the experiment currently loaded. If this is the first
time you are saving the experiment and you have not given it a name yet, you
will be presented with the standard “save file” box. See the description of the
next item, “Save As...”, for more details.

Save As

SuperLab Pro allows you to save your document as its own document, or
another application program's document. In all cases, the file contents are the
same; the only difference is which application runs when you try to open the
script in the Finder. Unless you are using another application to edit SuperLab
Pro scripts, save your script as “a SuperLab Pro document”.

Once you have selected the file type from the sub-menu, SuperLab Pro presents
the standard “save file” box and saves a copy of the current experiment with a
new script name you specify. Subsequent uses of Save (as opposed to Save
As...) will save changes you make to this new script.

The Save As sub-menu can be customized. If you use an application other than
Microsoft Excel or MacWrite II, choose the Customize This Menu menu item,
and click on the check mark (+') next to the application you would like to
change. SuperLab Pro will ask you to locate the application you would rather
see listed in the sub-menu. Click on OK. The application you just located will
now be listed in the Save As sub-menu.

Page Setup...
Print Script...

Not implemented in this release of SuperLab Pro.
Quit
Exits the program. If there is an experiment currently loaded and changes

made to it have not been saved, SuperLab Pro will remind you to save the
changes.
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The Edit Menu

HEH

Cut #H
Copy #C
Paste U
Clear

The Edit menu performs standard Macintosh functions you are already
accustomed to. The Cut, Copy, and Clear items in this menu will only operate
on one or more selected items of the experiment. They have no effect if no
experiment item is selected. A selected item is a block, a trial, or an event.
Cutting, copying, or clearing a block or a trial will also operate on its links (refer
to the Experiment Editor section for more on links). For example, if you cut a
block that has 3 trials linked to it, pasting it back will also restore the links to
these 3 trials.

Cut, Copy, and Paste do not work with the Codes Editor and the Responses
Editor.

When you Cut or Copy an item, you are limited to a fixed-size 10 kilobytes
buffer, which should be plenty for most needs. SuperLab Pro places the
contents in the Clipboard as straight text, in the same format used to save the
experiment to disk. This makes it possible to cut-n-paste not only within
SuperLab Pro, but also between SuperLab Pro and other applications.

The following describes items in the Edit menu.

Undo
Not implemented in this release of SuperLab Pro.

Cut

Makes a copy of the currently selected items and places it in the Clipboard, and
then deletes them.

Copy
Makes a copy of the currently selected items and places it in the Clipboard.

Paste

Pastes the Clipboard contents into the experiment. The Clipboard contents are
pasted in “insert” mode. For example, suppose you used Cut or Copy to place 4
trials in the Clipboard. When you Paste, SuperLab Pro will append the 4 trials
after all the existing ones if no trial is currently selected. But, if at least one trial
is selected, SuperLab Pro will insert the 4 trials currently in the Clipboard just
before the first selected trial.

Pasting in insert mode makes it possible to use Cut/Copy/Paste to change the
order of items in the experiment.

As discussed earlier, the event, trial, and block names must be unique. For
example, an event can have the same name as a trial, but no two event s may
have the same name. To enforce this rule, SuperLab Pro makes sure the items
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Tip: if you hold down the
Option key while selecting
Cut or Clear, SuperLab
Pro will not confirm the
deletion. Use with care!

being pasted have a unique name. It does so by adding a number at the end if
none already exists, or by adding 1 to the existing one. For example:

Trial 1 gets pasted as Trial 2
the trial gets pasted as the triall
event 589 gets pasted as event 590

This method of pasting can also be used to create experiment items quicker. For
example, to create 80 items, create the first one, copy it, and then paste it 79
times. It is much faster to create the trials this way then to create them
individually and type the name of each.

Clear

Deletes the currently selected items from the frontmost window. You can also
use the Delete key on your keyboard, it works identically. On some keyboards,
the key may be labeled Backspace.

If you are cutting or deleting an item referred to elsewhere in the experiment
(i.e. cross-referenced), SuperLab Pro will tell you so and confirm whether you
want to go ahead. Examples of items that can be cross-referenced: an event
linked to a trial, a trial linked to a block, a code name or code value used in a
trial, or a response used in an event.

Since the current release of SuperLab Pro does not implement the Undo feature,
be careful when you delete items.

The Experiment Menu

Codes Editor

Responses Editor

Input From...
Timer to Use...

Run...

%R

The Experiment menu lets you edit miscellaneous aspects of the experiment,
such as codes, responses, Input method, and timing method. You also use the
Experiment menu to run an experiment.

Background Color...
Opens the familiar color wheel. Click on the color you want, or type in the RGB
values of the desired background color. This feature works only on Macintosh
models equipped with Color QuickDraw, a piece of system software not
available on some Macintosh models. Examples of machines with Color
QuickDraw: all Mac II models, Quadras, SE/30, Classic II, Mac LC, and
PowerBook 140 and 170. In general, Color QuickDraw requires a Macintosh
with the MC68020 processor or later model.

Codes Editor
Opens the Codes Editor window. If it is already open, it is brought to the front.
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Responses Editor

Opens the Responses Editor window. If it is already open, it is brought to the
front.

input From...

Lets you choose the method you would like to use to obtain responses from the
subject. The list of available input devices appears in a scrolling list on the left
side of the dialog box. To the right, explanatory text provides some information
about the device.

In the context of this dialog box, the term “device” is used in a generic way. For
example, the first two choices on the list, Generic Keyboard and ADB Keyboard,
are physically the same, but the software (also called “driver”) used to get the
input from the keyboard is completely different.

Input Device to Use
With Experiment “new.script™:

Available Devices:

. e . This implernentation of an input device allows
Generic Keghoard E any keyboard to be used. It also distinguishes
ADB Keyboard between upper and lower case. Timing
NB-DID-24 Card resolution is a low £16.67 ms.

‘fou must use this driver if you're using a
Mac Plus, atherwise check out * ADE
Iy! Keyboard .
[Make I]efault] [Mz;z’@m] [[ 0K }] [ Cancel ]

At the bottom of the dialog box, four buttons are provided: the familiar OK and
Cancel, More, and Make Default. The More button brings up a smaller
subdialog. It is activated only if you select ADB Keyboard or NB-DIO-24 Card
because these two devices allow additional options:

= For ADB Keyboard, if you have more than one keyboard connected to
your Macintosh, the More subdialog allows you to set which keyboard to
use. Note that this choice of keyboards does not apply to “Generic
Keyboard” because the subject can provide responses on either keyboard.

For NB-DIO-24 Card, you can set the slot number where the card resides
and the duration of the debouncing period for the switches connected to
the card. The debouncing period varies depending on the type and quality
of the switches you decide to use.

The Make Default button makes the selected input device the one SuperLab Pro
will use next time you create an experiment. This information is stored in a file
called “SuperLab Pro Prefs” in your System folder. If you click on Make
Default, the selected device will be remembered even if you click on Cancel
afterwards.

For more complete information on input accuracy, see the chapter “On Timing
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And Input.”

Timer to Use...

Lets you choose the timer you would like to use to time the responses obtained

from the subject. The list of available timers appears in a scrolling list on the left
side of the dialog box. To the right, explanatory text provides some information

about the timer.

The Make Default button makes the selected input device the one SuperLab Pro
will use next time you create an experiment. This information is stored in a file
called “SuperLab Pro Prefs” in your System folder. If you click on Make

Default, the selected device will be remembered even if you click on Cancel
afterwards.

For more complete information on timing accuracy, see the chapter “On Timing

Timer to Use With
Experiment “new

Script”:

Available Timers:
TickCount s

Time Manager 1
Time Manager 2
IMA Chip

Uses the Toolbosx’ Time Manager. Ticks
every 1 ms and has a range of about a day
(per event, not per experiment).

Requires System 6.0.3 or later. See the
manual for details about Tatency.

(Make Default] |

0Kk || [cancel ]

And Input.”

Runs the experiment. You will first be presented with the dialog below. In it,
enter the subject’s name and select the starting block from the pop-up menu.
The dialog also contains three “check boxes,” where you get to choose
miscellaneous options.
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The ”Save collected data” is
an obvious one; if unchecked,
SuperLab Pro will simply not
save any results.

The Run in ‘debug’ mode
check box is an aid to help
you test and debug your

Subject's Name: || |

block 2

Start with Block:

& save collected o
[JRun in ‘debug’ mode
[ Recalculate all presentation times

scripts; if checked, SuperLab Pro will issue warnings that otherwise will

not appear.

The last check box, Recalculate a
special cases. Depending on the

1l presentation times, is used only in
particular event or stimulus, SuperLab

Pro may need to know before starting the experiment how long the
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stimulus takes to present. Normally, the software tries to record this
information — either from previous runs or from previewing the stimulus
while you were editing it. There are times, however, when you might feel
that recalculation of all presentation times is necessary. If that’s the case,
turn this option on.

Next, if “Save collected data” is checked, you will be presented with a standard
“Save File” box where you need to specify the name of the results output file.
Click on the Save button to proceed with the experiment.

To cancel an experiment in progress and the input is from the keyboard, press
Command-Period, that is, hold the Command key (3) down and then press the
period (.) key simultaneously.

To cancel an experiment in progress and the input is from the National
Instruments i/0 card, hold the Command key (3) down and then press any of
the card buttons simultaneously.
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Chapter 6 - File Formats Reference

SuperLab Pro’s scripts are saved in plain text tab-delimited files. So are the
results collected when you administer an experiment to subjects. This section
provides a detailed reference to both.

Description of SuperLab Pro’s Scripts

You can edit the entire experiment interactively, but there may be cases where
you need to use a text editor to edit the scripts directly or have them auto-
generated by another program.

Here is a sample script fragment and some general notes.

* This is a sanple SuperLab Pro script file.
#Ti m ng- Met hod 1

#Codes
Difficulty easy diff none
Speed sl ow f ast

#Responses
vY
nN

When reading a script, SuperLab Pro does not distinguish between upper and
lower case. Use whichever you like. However, when writing out experiment
files, SuperLab Pro will use English-like mixed upper and lower case. You can
have up to 130 characters per line, but it is suggested you do not exceed 80
characters.

SuperLab Pro keywords begin with a pound sign (#), also known as the number
sign. In the example above, #Codes, #Responses, and #Timing-Method are all
keywords. A keyword may be followed by one or more parameters, not



#Script-Version

#Background-Color

necessarily on the same line. Some keywords can handle a variable number of
parameter lines. For example, you may have from 1 to 46 possible responses
following the #Responses keyword. When this is the case, SuperLab Pro will
keep reading parameters automatically until it reaches the next keyword, or the
end of file.

There is only one restriction to the way you name your parameters, regardless
of whether you are using SuperLab Pro or a text editor to edit the script: the first
letter may not be a double quote ("). For details on this restriction, see the
section “Microsoft Excel Blues” later in this manual.

You can add comments to a script; the program will ignore any line where the
first character is an asterisk (*). In-line comments are not supported, i.e. you
cannot place a comment on the same line after a keyword or parameter; a
comment must occupy a line by itself. Another drawback is that SuperLab Pro
does not remember original comments in a file. For example, suppose you
placed comments in your script using a text editor. You then run SuperLab Pro,
open the script, make a change, and save the script. The original comments you
placed in the script will be lost because SuperLab Pro has no way of
remembering which comment was where.

The following describes every keyword. They are not listed in alphabetical
order, but rather in the same order SuperLab Pro would use when saving an
experiment. Some keywords must be specified before others to avoid cross-
referencing problems. For example, #Trials and #Events must both precede
#Trial-Events; #Codes must be specified before #Trials, etc.

The format version of the script. As new features are added, the script format
as described in this manual may need to be changed or updated. SuperLab Pro
will always read all previous versions, but saves a script only in the most recent
version. Takes 1 parameter, on the same line following the keyword.

The background color to use when presenting the subject with visual stimuli.
Takes 3 parameters, on the same line following the keyword. The first
parameter is the red component of an RGB color value, the second parameter is
the green component, and the third is the blue component. Valid range is from
0 to 65535. Example:

#Backgr ound- Col or 65535 65535 65535

The color (65535,65535,65535) is white. If you are using a black and white Mac
(e.g. Mac Plus, Classic, SE), SuperLab Pro will simply ignore this keyword.
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#Background-Pattern

#Background-Size

#Input-Method

#Timing-Method

#Codes

Obsolete.

Obsolete.

The input method to use when you record the subjects’ responses. Takes 4
parameters, on the same line following the keyword. The first parameter takes
one of the following values:

gnrc Use any (generic) Macintosh keyboard.

adbl1 Use an Apple Desktop Bus (ADB) keyboard.

nb24 Use a National Instruments 8255-based i/o0 card.

nb16 Use the National Instruments NB-MIO-16 card.

ctsp Use the Serial Port CTS input module.

micl Use the Microphone module.
Parameter 2 is the debouncing time, if applicable. Parameter 3 is the device’s
address, if applicable. Parameter 4 is reserved for each device’s use.

The timing method to use when timing the subjects’ responses. Takes 1
parameter, on the same line following the keyword. Valid parameter values
are:

tick Use Macintosh “TickCount,” + 16.67 ms.

tmrl Use Toolbox “Time Manager,” + 1 ms.
tmr2 Use Toolbox “Time Manager,” + 20 ps.

List of code names and code values that may be assigned to trials for post-
experiment analysis. Takes a variable number of parameter lines, starting at the
next line. Example:

#Codes

Difficulty easy diff none

Speed sl ow f ast

My Code codel code2 code3 code4d
My Code code5 code6

The first field on a parameter line is the code name. The following fields in the
line, separated by tabs, are the code values. You can list code values on more
than one line, as long as you specify the code name in the first field of every
line. In the example above, My Code has 6 values, with the first 4 declared on
one line and the remaining 2 on the next line.
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#Responses

Note: if you want to alter
the response ID, make
sure you also alter any
corresponding IDs in the
“Correct Response” field of
the #Events keyword.

#Feedbacks

#Events

List of SuperLab Pro responses. Takes a variable number of parameter lines,
starting at the next line. Example:

#Responses
yY 201
nN 202

Each parameter line has two or more fields. The first is the response’s “label,”
often the same as the response itself. The second is the response’s ID. More
fields may follow depending on the selected input device.

The maximum number of responses you can have depends on the chosen input
device; see the chapter “On Timing and Input” for more information.

List of feedbacks. Takes a variable number of parameter lines, starting at the
next line. Example:

#Feedbacks

* Al feedbacks are declared here
good feed

bad feed

no feed

All the #Feedbacks keyword allows for is a “declaration” of what the feedbacks
are. It does not describe or tell anything about them.

List of events (stimuli, etc.) that in the end form the experiment. Takes a
variable number of parameter lines, one line per event. For convenience and
readability, the next two lines provide the names of fields contained in each
parameter line. Example:

#Event s

* Event Event Response M sc. Correct
** Name Type Acti on Duration Flags Response
ny pict vi sl 3 1000 1 -2
clint odi o 2 0 5 -2

nmy sound odio 2 0 1 -2

Each event parameter line has six fields. The first is the event name. It must be
unique, meaning no two events may have the same name.

The second field is the event type. Currently, event type may be one of the
following values:
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Note: when the manual
says a (numeric) field may
not be used, it is best if it is
not empty either. Specify
any value, preferably zero.

#Digital-Output

When event See also

type is The event is... description of keyword:
dout a digital output line control #Digital-Output

wait an inter-stimulus interval

visl a visual stimulus #Picture-File

odio an auditory stimulus #Sound-File

The third field, labeled “Response Action,” determines how a stimulus is
terminated, as follows:

When

Value is The event...

1 does not require user input, will terminate automatically after a
set amount of time

2 requires user input, will not terminate until one is obtained

3 requires user input, will terminate when one is obtained or
automatically after a set amount of time, whichever comes first

4 requires user input, will terminate automatically after a set

amount of time, even if the user responds correctly

The fourth field, “Duration,” is a time unit in milliseconds. This field is used
only if the previous “Response Action” field’s value is 1, 3, or 4.

The fifth field, “Terminate On,” specifies what terminates a stimulus, as follows:

1 Any response from the subject terminates event.
2 Only correct response terminates event.

The sixth and last field, “Correct Response,” is used only if the previous
“Terminate On” field’s value is 2, that is, only the correct response from the
subject terminates the event. It specifies what is considered the “correct”
response. This is the order number of the response specified earlier with the
#Responses keyword. For example, if we have:

#Responses
yY
nN

then the “Correct Response” field will be 1 if yY is the correct response, or 2 if
nN is the correct response.

SuperLab Pro will save a #Digital-Output parameter line for every event of type
“dout.”
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#Picture-File

SuperLab Pro will save a #Picture-File parameter line for every event of type
“visl.” Here’s a sample:

#Picture-File
* Event File Dir Vert Horiz Vert Horiz Msc. Play Lead

** Nane Nanme ID Size Size Pos. Pos. Flags Time Tine
Rsrvd

pict 2 dot 1347 300 300 50 50 3 499 1000 0
pict 3 square 1347 0 0 0 0 294 98 0 0
pict 1 circle 1347 200 450 10 0 2339 -1 200 0

The first field is the event name, as previously declared with the #Events
keyword. The second field is the name of the PICT file the event uses, and the
third field, “Dir ID,” helps SuperLab Pro locate the file on your disk.

The “Vert Size” and “Horiz Size” fields specify respectively the vertical and
horizontal dimensions of the picture, in pixels. When set to zero, it usually
means they are not used. See the description of the “Misc. Flags” field for more
details.

The “Vert Pos.” and “Horiz Pos.” fields specify respectively the picture’s
vertical (Y coordinate) and horizontal (X coordinate) , measured from the center
of the screen to the center of the picture.

The “Misc. Flags” field contains miscellaneous information about the picture.
All the information is packed into this field by using individual bits; the format
is as follows:

1514 13121110 9 8 7 6 5 4 3 2 1 O

[I TIILLITILITIIITLL]

AN AN /\

|:| = Reserved Bit

The numbers 0 through 31 indicate the bit’s .

Bits 0-1 Picture’s frame () attribute. 0 (zero) is reserved; 1 means scale
picture to fit display; 2 means use the picture frame as specified
inside the PICT file; and 3 means use the frame specified by the
user in the “Vert Size” and “Horiz Size” fields.

Bits 2-3  Center Vertical attribute. A value of 1 will center the picture
vertically on the screen. 0 (zero) means use the Y coordinate
specified by the user in the “Vert Pos.” field.

Bit 4 Reserved.

Bits 5-6  Center Horizontal attribute. A value of 1 will center the picture
horizontally on the screen. 0 (zero) means use the X coordinate
specified by the user in the “Horiz Pos.” field.

Bit 7 Reserved.
Bit 8 Keep Previous attribute. If equal to 1, SuperLab Pro will not
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#Auditory

erase the screen before drawing the picture.

Bit9 Keep Invisible attribute. Applicable only if your Mac is
equipped with the necessary video equipment. If this bit is set
to 1, SuperLab Pro will turn the video off, draw the picture
while you cannot see it, and leave the video turned off. If the bit
is set to 0, SuperLab Pro will turn the video back on.

Bit 10 Use Instant Switching. Applicable only if your Mac is equipped
with the necessary video equipment. If set to 1 (the default),
SuperLab Pro will turn the video off, draw the picture while you
cannot see it, and then turn the video back on. This has the
effect of making the picture appear instantaneously (hence the
name Instant Switching). If the bit is set to 0, SuperLab Pro will
leave the video alone and you will see the picture being drawn
on the screen, especially if it takes more than half a second to
draw.

Bit 11 Do Auto Lead. In the events editor, you can specify a lead time,
that is, how long you want SuperLab Pro to wait before drawing
the picture. If this bit is set to 0, SuperLab Pro will wait the
amount of milliseconds specified in the “Lead Time” field. If set
to 1, SuperLab Pro will wait “Lead Time” minus “Play Time”
milliseconds. In other words, the lead time includes the time it
takes to draw the picture.

Bits 1231 Reserved.

The “Play Time” field contains the time it takes to present the picture on the
screen, in milliseconds. A value of -1 indicates an unknown time. SuperLab
Pro usually records this value when you the picture.

The “Lead Time” field stores how long you want SuperLab Pro to wait before
drawing the picture. The last field is reserved for future use.

Optional list of parameters for auditory stimuli. The #Auditory keyword gives
you the chance to change these defaults. But in all cases, when saving the
script, SuperLab Pro will save a #Auditory parameter line for every event of
type “odio,” whether you have edited the defaults or not.

Here’s a sample:

#Audi t ory

* Event File Dir Standard Custom

** Name Nane ID Vol une Rat e Frequency Asynch
clint dint 483 2 4 0 0
nmy sound wnoi se 483 1 3 0 0

The first field is the event name, as previously declared with the #Events
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#Trials

keyword. The second field is the name of the System 7 or SoundEdit file the
event uses, and the third field, “Dir ID,” helps SuperLab Pro locate the file on
your disk.

The “Volume” field sets the volume level for the internal speaker. Valid range
is 0 (zero) to 7. 0 will turn the speaker off, 1 is the lowest volume, and 7 is the
loudest volume. This feature may not be supported in future versions of
SuperLab Pro.

The “Standard Rate” field is no longer used.
The “Custom Frequency” field is reserved for future use.

The “Asynch” field plays the sound asynchronously if it is set to 1, meaning
that SuperLab Pro will continue with the next event while the auditory stimulus
is still being played. If set to 0, SuperLab Pro waits until the stimulus is done
playing before proceeding with the next event. This feature may not work well
on Macintosh models not equipped with the Apple Sound Chip. All Mac II
models have the ASC. Others may or may not, check your Owner’s Guide.

List of SuperLab Pro trials. Takes a variable number of parameter lines, one line
per trial. The first field on a parameter line is the trial’s name. The remaining
fields, arranged in a “table” layout, are the code values as previously declared
with the #Codes keyword. Example:

#Codes

Difficulty easy diff

Speed sl ow medi um f ast
#Trial s

* Codes: Difficulty Speed

Trial 1 easy sl ow

Trial 2 easy medi um

Trial 3 diff

Trial 4 f ast

In this example, we have two codes and four trials. On the parameter lines
following the #Trials keyword, the first field is the trial’s name, and the
remaining fields are the code values associated with the trial. It is possible to
have a trial with no code values in it; in the above example, Trial 3 has no Speed
code while Trial 4 has no Difficulty code.

Note that there is a commented line following the #Trials keyword, providing
the code names. It is not required, but when you save an experiment, SuperLab
Pro will automatically insert it for clarity’s sake.
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#Blocks

#Block-Trials

#Trial-Events

List of SuperLab Pro blocks. Takes a variable number of parameter lines, one
line per block, starting at the next line. Example:

#Bl ocks

Bl ock 1 0 0
Bl ock 2 1 0
Bl ock 3 1 55
Bl ock 4 0 0

The first field on a parameter line is the block’s name. The second field is 1 if
trials in the block should be randomized before running the experiment; else it
is 0. The third field is the seed for the random function; if 0, SuperLab Pro will
chose its own seed based on elapsed time. Otherwise it will use the seed you
provide. In the example above, Block 2 and Block 3 are to be randomized.

List of trials “belonging” to a block. One trial can belong to (be associated with)
more than one block. The first field on a parameter line is the block’s name.
The remaining fields are the trials’ names, as previously declared with the
#Trials keyword. Example:

#Bl ock-Trial s

Bl ock 1 Trial 1 Trial 2 Trial 3
Bl ock 2 Trial 4 Trial 5 Trial 6
Bl ock 2 Trial 7 Trial 8

You can list trial names on more than one line, as long as you specify the block
name in the first field of every line. In the example above, Block 2 has 5 values,
with the first 3 declared on one line and the next 2 on the next line.

List of events “belonging” to a trial. One event can belong to (be associated
with) more than one trial. The first field on a parameter line is the trial’s name.
The remaining fields are the events’ names, as previously declared with the
#Events keyword. Example:

#Tri al - Event s

Trial 1 Event 1
Trial 2 Event 2
Trial 3 Event 3

You can list event names on more than one line, as long as you specify the trial
name in the first field of every line.
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#Feedback-To-Events

#Feedback-Events

List of feedbacks to events. Feedbacks are presented to the subject in one of
three cases: response is correct, response is incorrect, or there is no response
within a certain time limit. Example:

#Feedback- To- Event s
* Correct Incorrect No Response Time Limt
Event 1 bad feed no feed 5000

The first field on a parameter line is the event’s name, as previously declared
with the #Events keyword. The remaining three fields are the feedbacks’
names, as previously declared with the #Feedbacks keyword. The last field is
the time, in milliseconds, that SuperLab Pro should wait before presenting the
“no response” feedback. A field is left empty for cases when no feedback is to
be provided.

List of events “belonging” to a feedback. One event can belong to (be associated
with) more than one feedback or trial. The first field on a parameter line is the
feedback’s name, as previously declared with the #Feedbacks keyword. The
remaining fields are the events’ names, as previously declared with the #Events
keyword. Example:

#Feedback- Event s

good feed good nessage
bad feed bad nessage
no feed wakeup nmessage

You can list event names on more than one line, as long as you specify the
feedback name in the first field of every line.

The Search Order for Data Files

After loading and parsing the experiment’s script, SuperLab Pro loads all the
data files associated with the experiment, e.g. pictures and sounds. Two pieces
of information about a data file are stored in a script, the file name and the
directory ID. The directory ID is a number that identifies the folder in which
the data file is located on your disk; each folder has a unique ID on any one
disk.

Normally, a third piece of information would be needed, one that specifies
which disk the file is on. However, it is nearly impossible to identify a disk
with a unique number or name, so SuperLab Pro does not store the disk
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information. Here is how the search for data files is done:

1.

Using the file name and directory ID, the program tries to load the file
from the default disk; this is the disk you started your Mac with.

If not found, SuperLab Pro will search all other disks currently available
to your Mac (floppy, optical drive, SyQuest or Bernoulli removable drive,
etc.) for a file with a matching name and directory ID.

If still not found, SuperLab Pro then searches the default folder and the
System Folder. The default folder is where you last looked for a script or
a data file.

If still not found, SuperLab Pro gives up and presents a dialog box asking
you to locate the data file. Once you have located the file, the new
directory ID is then remembered and recorded when you save the script.

Normally, this search sequence is invisible to you, except, of course, if you are
asked to locate a file. There are reasons why sometimes SuperLab Pro cannot
find a file. You may have inadvertently deleted or renamed the file. Or maybe
you moved the file from the folder it was in to another location on the disk. Or,
if you edited the script using a text editor or a spreadsheet program, you may
have typed over the directory ID stored in the script.

Note that, if you move the entire folder from one location to another on the same
disk, SuperLab Pro will still find the file.

Description of the Collected Results File

SuperLab Pro records all the responses provided by the subjects, whether
correct or not. These are saved in a tab-delimited text-only file.

John Doe
Letter Rotation
9/23/87 20:07

Trial Hame | Trial * | Event *# | Pesponze |Error Code| Reaction Time | letters | orientation| Fand B | Rand L

instructions 1 1 C 1146
1 2 2 C 1446 L 150 front right
2 3 3 C 63 F a0 front Teft
3 4 4 E 1746 F 0 back right
3 4 4 b sC 2596 F 0 back right
4 5 5 C 913 R 150 front Teft
5 & ] E 1880 L a0 back right
5 & ] b sC 2763 L a0 back right
3] 7 7 E 2246 L 180 back right
3] 7 7 E 4430 L 180 back right
3] 7 7 b 5C 5113 L 180 back right
7 g g E 913 [ 60 back right
7 g g b 5C 1696 [ 60 back right
g 9 9 C 1429 F 30 front right
9 10 10 C 563 L 60 front Teft
10 11 11 b C 79 [ u] back riaht

The above snapshot of the results file has been formatted for presentation’s
sake; the results file you obtain will be plain text.
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The first field is the trial name. The second field is the trial number (order). The
reason for this redundancy is because a trial number is easier to process with
statistical software than a name.

The third field is the event number, followed by the subject’s response. In the
snapshot above, responses are either blank (space bar) or the character B.

The fifth field contain an error code. SuperLab Pro generates a C for correct, an
E for error, or an SC for self-correct, meaning the subject responded previously
with a wrong answer than responded with the correct one. The error code is
followed by the reaction time, in milliseconds.

A varying number of fields follow the reaction time. These are the code values
attached to the trial. The number of fields depend on how many codes you
have defined.
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Chapter 7 - More On SuperLab Pro

This chapter discusses additional topics of interest. Some are intended for the
curious or technically oriented users. Others have a wider intended audience.

Frequently Asked Questions

This section provides some answers to frequently asked questions by SuperLab
Pro users.

Q. The visual stimulus does not get centered, even though | am asking SuperLab Pro
to center it. In fact, sometimes it does not even appear on the screen. Why?

A.  When saving the picture file, some software like SuperPaint save the entire
“page” instead of just the object you created. To solve the problem in
SuperPaint 3.0, chose “Document Info” from the File menu and set the
document height and width to fit your stimulus. We suggest that you use the
same height and width for all your stimuli.

Q. The visual stimulus appears in the wrong colors, even though in looks fine in the
program that | used to create it, scan it, or edit it. Why?

A.  The problem is due to the color lookup table (CLUT) not being properly set.
This usually happens if you use the Instant Switching feature. To make sure the
CLUT is properly stored, you can use Adobe Photoshop or NIH Image.

In Adobe Photoshop 2.5, open the picture file, specify 8-bit index color and
system palette, and re-save. This technique will usually work only if you run
the experiment on the same machine because the system palette will vary from
Mac to Mac.

If using NIH Image, open and re-save the experiment. We suggest you do this
on the same machine that you'll be running the experiment on, although it may
also work on other machines. Image is free and can be downloaded from many
locations on the Internet.

Q. Iam trying to run an experiment using the microphone as voice key and



presenting some audio stimuli. The audio stimuli do not play. What is the
problem?

Apple advertises the Macintosh as capable of both audio in and audio out.
However, only the higher end Mac models are capable of doing both at the
same time. On the smaller (or lower end) Macs, you can only do one or the
other at any one time, but not both.

To check that this is indeed the problem in your case, switch the input device
from Microphone to Generic Keyboard. If the sounds will now play, than your
Mac is not capable of accepting input from the microphone and playing audio
sounds at the same time. Using a third party product like MacRecorder usually
solves the problem. MacRecorder connects to a serial port.

If, after switching the input device from Microphone to Generic Keyboard, the
sounds will still not play, you may be having a memory problem or corrupted
sound files. Please contact Cedrus tech support; we’ll be glad to assist you.

I am unable to use the microphone as voice key. Why?

Typically, this is a problem not related to SuperLab Pro. To check, chose
“Control Panels” from the Apple menu and double-click on the Sound control
panel to open it. Try to record and playback a sample using this control panel;
see the Apple documentation for more information on how to do this.

If you cannot record the sound and play it back, check your software and
hardware. In particular, make sure you have the right type of microphone.
Once you manage to record a sample using the Sound control panel, voice key
should work fine in SuperLab Pro.

In the Events Editor, when | try to load my visual stimulus, the name of the picture
file does not even appear in the “get file box.” Why?

Make sure you save your picture as PICT or PICT2. Almost all drawing
programs on the Mac support the PICT standard. However, most save the
picture in a format particular to the program you use, unless you specifically
ask it to save as PICT.

My visual stimulus takes too long to display. Anything I can do about it?

Maybe. Not all pictures (or visual stimuli) are created equal. Check the
upcoming section, “Visual Tips.”

SuperLab User’s Guide



Occasionally, when | want to quit SuperLab Pro, it asks me if | want to save the
changes, even though I do not recall making any. How come?

A number of things could cause SuperLab Pro to remind you about saving the
changes. Some are features, others are not.

For example, when loading the script and the data files associated with it, there
are times when the program cannot locate a particular data file and it prompts
you for its location. After you have located it, SuperLab Pro then records the
new location. This is considered a change that needs to be saved, otherwise you
will be asked to locate the file every time you open the script.

Another example is when you edit a picture’s or . This affects how long it takes
to draw the picture on the screen, and therefore the drawing time saved with
the script is changed.

Also, anytime you are presented with a dialog box, if you click on OK instead of
the Cancel button, SuperLab Pro records it as a change even if you didn’t
change anything. This one is not a feature; this behavior will be improved in a
future release.

When | open an experiment’s script, SuperLab Pro sometimes says it can not
locate one or more of the stimuli data files (pictures, sound, etc). Why?

This could be due to the fact that you moved the data file from a folder to
another, or from one disk to another. Once you have located the files, SuperLab
Pro will record the new location and will not bother you the next time. For
more information, see the section “The Search Order for Data Files” in chapter
6.

How can | save a tree?

One way you can help is by reducing the quantity of junk mail you receive. In

the U.S., write to the Direct Marketing Association and ask them to strike your

name from mailing lists used by member companies. Write to: DMA, Mail and
Telephone Preferences Services, Six E. 43rd St., New York, NY 10017.

Other major sources that sell, rent, or otherwise distribute your name are
magazines you are subscribed to and professional associations. You can write
to them too to limit the distribution of your name.

Hey, this section is titled Frequently Asked Questions; it did not say they had to
be about SuperLab Pro!
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Q. If two or more visual stimuli use the same picture file, does SuperLab Pro keep
multiple copies of the picture in memory?

A.  No, no matter how many stimuli use a picture , SuperLab Pro keeps only one
copy in memory. The same holds true for auditory files.

Microsoft Excel Blues

This section is of interest to those of you using Microsoft Excel 2.2 or later to
edit SuperLab Pro scripts.

Here’s a script fragment we can use as an example in the following discussion:

#Picture-File

F-1 test L Aaker,N 1158 0 0 265
F-1 test R Abraham G 1158 0 0 0
F-3 acq Andrews, A 1158 0 0 0
F-4 test L Anmira,P 1158 0 0 0

To refresh your memory, the first parameter of a #Picture-File keyword is the
event name, followed by the stimulus’ file name, folder ID, and so forth.

As originally written, SuperLab Pro would read its scripts as is. One day, one
of our beta testers edited the script above using Microsoft Excel 2.2 and saved
the changes. This is how Excel saved it:

#Picture-File

F-1 test L "Aaker,N' 1158 0 O 265
F-1 test R "Abraham G' 1158 O 0 0
F-3 acq "Andrews, A" 1158 O 0 0
F-4 test L "Amra,P" 1158 0 O 0

Notice the addition of double quotes on the second field. As it turns out, if a
cell in Excel contains a comma or a double quote, then the entire cell gets
double-quoted when saved to disk. Here are some examples:

My Nane gets saved as My Nane

Aaker, N gets saved as " Aaker, N'

This "is" it gets saved as "This ""is"" it"
"Test!" gets saved as """Test! """

To work around this “feature,” we modified SuperLab Pro to handle these
quotes. This imposes a restriction on the way you name your events, trials, etc.:
the first letter may not be a double quote.
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Visual Tips

Object Pictures

Is your visual stimulus taking too long to display? Or at least longer than you
would like it to? There may be something you can do to shorten the display
time without rushing to buy the latest and greatest piece of hardware. Here are
a few tips.

When using “object drawing” programs like MacDraw II or MacDraft, you may
be putting into your rectangles, circles, and polygons more than you realize.
This is because such software lets you have a choice between a transparent
object and a white-filled object. They both look the same on the screen, but they
are not. In the following discussion, we will use MacDraw II as an example.

The picture on the right is a snapshot of the
top left corner of a MacDraw II window. On
the left, you have the standard choice of tools.
Under the window’s title bar, you have a
choice of patterns. The leftmost one shows

the currently selected fill pattern. To select a é,va,:tﬂable
. . : 1 m
different fill pattern, simply click on the one CsuTeTtg] aem
clecte
you want. Fill Pattern

Of the available patterns, notice the two on

the left: one is marked with an asterisk (*) and the other is white. When
drawing a rectangle, circle, or polygon, selecting the white pattern will fill the
object with solid white. On the other hand, selecting the asterisk will make the
object “transparent.” Here is an example using rectangles drawn over a dotted
pattern:

The point behind all this is that you should use transparent rectangles
whenever possible. They are much faster to draw. With filled rectangles, the
Macintosh draws the rectangle and then fills it, even if the color is set to white.
It is this filling operation that makes a picture take longer to display.
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In SuperLab Pro, if you have selected white as the experiment’s background, the
subtle change described above will not be apparent. You may want to change
the color or pattern to non-white temporarily, run the experiment to check for
white-filled objects, and then restore the desired background.

Scanned Images Some experiments may involve presenting photographs or other images. These
are usually brought to the Macintosh using a scanner, a device similar to a
photocopying machine except that its output is a data file instead of paper. A
scanner is usually shipped with its own custom software to take full advantage
of the hardware’s features, such as the choice of color and resolution.

The choice of colors typically includes black and white, gray scale, 256 colors, or
16 million colors. As a rule, do not ask for more colors than your Macintosh can
display. If you have a Classic or an SE/30, select black and white. If you have a
color Mac with a 256-color video card, scan your picture using 256 colors, not 16
million. Even if you have a 24-bit video card capable of displaying all 16
million colors, you may still want to use 256 colors only to reduce memory
requirements and the time it takes to display a picture.

The choice of resolution should always be 72 dots per inch (dpi), simply
because this is the standard resolution of a Macintosh display. Some scanners
let you scan at 144, 300, or 600 dpi, but increasing the resolution beyond 72 dpi
will significantly increase the memory and storage requirements, as well as the
time it takes to display the visual stimulus. If you need to print the image on a
laser printer, consider scanning two copies of the image, one at 72 dpi for faster
display as a visual stimulus, and another at 300 dpi for better quality printing.

Switches for the National Instruments 1/0 Card

This section describes how to connect pushbuttons to a National Instruments
NB-DIO-24 i/0 card. These hints also apply to the other supported models.

The National Instruments” NB-DIO-24 digital i/o card is NuBus card with 24
lines that can be used for either input or output. These lines are separated into 3
ports, with 8 lines each. SuperLab Pro uses Port A for input.
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If you decide to use this card, you will need to build a box for your subjects to
use. You need to use a 50-pin flat ribbon cable between your box and the card.
The box may contain up to 8 switches, depending on your experiment’s needs.
The switches must be connected to pins 47, 45, 43, 41, 39, 37, 35, and 33. For
example, pin 47 is PAQ, button 1; pin 33 is PA7, button 8. For each switch, you
need a push button and a 10 kilo ohms (k®) pull-down resistor, wired as
illustrated in the diagram on the left.

The NB-DIO-24 card contains a jumper to set interrupts. Shipped from the
factory, this jumper is set to “None,” meaning no interrupts. This is the
required setting for SuperLab Pro.

For more information and diagrams, refer to your National Instruments
“NB-DIO-24 User Manual.”
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Appendix - Further Readings

Here are further readings and references you can check out. Some are of a
highly technical nature and oriented towards programmers.

For an overview of the Macintosh sound capabilities, the July 1991 issue of BYTE
magazine contains an excellent article entitled Macintosh Sound Revealed (page
249), by Jim Reekes, the Apple software engineer responsible for updating the
Mac’s Sound Manager software, and Tom Thompson, a BYTE senior editor at
large. See also the Sound Manager chapter in Inside Macintosh, volume 6.
Note: volume 5 also contains a Sound Manager chapter; skip that one
altogether.

For technical information on the Apple Desktop Bus (ADB), see the Guide to
Macintosh Family Hardware. In the second edition, chapter 8 is dedicated to the
ADB. In particular, check the section entitled ADB Commands on pages 221-223.
For more details, see the Apple Desktop Bus chapter in Inside Macintosh
volume 5, and Technical Note #206, Space Aliens Ate My Mouse, published by
Apple’s Developer Technical Support (DTS).

For more details about timing, see the Time Manager chapter in Inside
Macintosh, volume 6.






License Agreement

In Plain English

Some Frequently
Asked Questions

The Complete
Legal Text

Nearly every software license sold is governed by a license agreement,
sometimes called an End User License Agreement (EULA). Here is the EULA
that governs the use of SuperLab Pro, first in plain English.

It's really simple:
No two persons may use SuperLab Pro at any one time.
Whenever in doubt, refer to item 1 above.

Our EULA offers more flexibility than other vendors', many of whom insist that
the software may be installed on one machine only.

Can I develop an experiment on one computer and run it on others?

No. You can run SuperLab Pro to develop and collect data on only a single
computer. If you only one to collect data (but not develop and experiment or
modify it) on other computers, Cedrus offers inexpensive "run only" licenses.

Can I install SuperLab Pro on the computer in the office and the one at
home?

Yes, provided there is no chance that another person may use it while you're
using SuperLab Pro at home.

END-USER LICENSE AGREEMENT FOR CEDRUS SOFTWARE

IMPORTANT — This End-User License Agreement (“EULA”) is a legal
agreement between you (either an individual or a single entity) and the
PUBLISHER from whom you acquired the software product SuperLab Pro or
SuperLab LT identified above (“SOFTWARE"). The SOFTWARE includes
computer software, the associated media, any printed materials, and any
“online” or electronic documentation. By installing, copying or otherwise using
the SOFTWARE, you agree to be bound by the terms of this EULA. If you do
not agree to the terms of this EULA, Cedrus Corporation (“Cedrus”) is
unwilling to license the SOFTWARE to you. In such event, you may not use or
copy the SOFTWARE, and you should promptly contact Cedrus for instructions
on return of the unused product(s) for a refund.



Software LICENSE

The SOFTWARE is protected by copyright laws and international copyright
treaties, as well as other intellectual property laws and treaties. The
SOFTWARE is licensed, not sold.

1. GRANT OF LICENSE.

This EULA grants you the following rights:

Software. You may install and use one copy of the SOFTWARE on a
computer.

Storage/Network Use. You may also store or install a copy of the
computer software portion of the SOFTWARE on the computer to allow
your other computers to use the SOFTWARE over an internal network,
and distribute the SOFTWARE to your other computers over an internal
network. However, you must acquire and dedicate a license for the
SOFTWARE for each computer on which the SOFTWARE is used or to
which it is distributed. A license for the SOFTWARE may not be shared
or used concurrently on different computers.

Back-up Copy. You may make a single back-up copy of the
SOFTWARE. You may use the back-up copy solely for archival
purposes.

2. DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS.

Limitations on Reverse Engineering, Decompilation and Disassembly.
You may not reverse engineer, decompile, or disassemble the
SOFTWARE, except and only to the extent that such activity is expressly
permitted by applicable law notwithstanding this limitation.

Separation of Components. The SOFTWARE is licensed as a single
product. Its component parts may not be separated for use on more than
one computer.

Single COMPUTER. The SOFTWARE is licensed as a single integrated
product. The SOFTWARE may only be used with a single computer.

Rental. You may not rent or lease the SOFTWARE.

Software Transfer. You may permanently transfer all of your rights
under this EULA provided you retain no copies, you transfer all of the
SOFTWARE (including all component parts, the media and printed
materials, any upgrades, and this EULA), and the recipient agrees to the
terms of this EULA. If the SOFTWARE is an upgrade, any transfer must
include all prior versions of the SOFTWARE.

Termination. Without prejudice to any other rights, Cedrus may
terminate this EULA if you fail to comply with the terms and conditions
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of this EULA. In such event, you must destroy all copies of the
SOFTWARE and all of its component parts.

3. UPGRADES.

If the SOFTWARE is an upgrade from another product, whether from Cedrus or
another supplier, you may use or transfer the SOFTWARE only in conjunction
with that upgraded product, unless you destroy the upgraded product. If the
SOFTWARE is an upgrade of a Cedrus product, you now may use that
upgraded product only in accordance with this EULA. If the SOFTWARE is an
upgrade of a component of a package of software programs which you licensed
as a single product, the SOFTWARE may be used and transferred only as part
of that single product package and may not be separated for use on more than
one computer.

4. COPYRIGHT.

All title and copyrights in and to the SOFTWARE (including but not limited to
any images, photographs, animations, video, audio, music, text and “applets,”
incorporated into the SOFTWARE), the accompanying printed materials, and
any copies of the SOFTWARE, are owned by Cedrus or its suppliers. You may
not copy the printed materials accompanying the SOFTWARE. All rights not
specifically granted under this EULA are reserved by Cedrus.

5. DUAL-MEDIA SOFTWARE.

You may receive the SOFTWARE in more than one medium. Regardless of the
type or size of medium you receive, you may use SOFTWARE on only one
computer. You may not use or install the other medium on another computer.
You may not loan, rent, lease, or otherwise transfer the other medium to
another user, except as part of the permanent transfer (as provided above) of
the SOFTWARE.

6. PRODUCT SUPPORT.
Product support for the SOFTWARE is provided by Cedrus or its resellers.
7.U.S. GOVERNMENT RESTRICTED RIGHTS.

The SOFTWARE and documentation are provided with RESTRICTED RIGHTS.
Use, duplication, or disclosure by the Government is subject to restrictions as
set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and
Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and
(2) of the Commercial Computer Software—Restricted Rights at 48 CFR 52.227-
19, as applicable. Manufacturer is Cedrus Corporation/532 E. Maryland
Ave/Suite B3 /Phoenix, AZ 85012.

8. LIMITATION OF LIABILITY.

Chapter 6 - More on SuperLab 69



Under no circumstances and under no legal theory, tort, contract, or otherwise,
shall Cedrus, its suppliers, or resellers be liable to you or any other person for
any indirect, special, incidental, or consequential damages of any character
including, without limitation, damages for loss of goodwill, work stoppage,
computer failure or malfunction, or any and all other commercial damages or
losses. In no event will Cedrus be liable for any damages in excess of the
amount Cedrus received from you for a license to the SOFTWARE, even if
Cedrus shall have been informed of the possibility of such damages, or for any
claim by any other party. This limitation of liability shall not apply to liability
for death or personal injury to the extent applicable law prohibits such
limitation. Furthermore, some jurisdictions do not allow the exclusion or
limitation of incidental or consequential damages, so this limitation and
exclusion may not apply to you.

9. HIGH RISK ACTIVITIES.

The SOFTWARE and the output produced by the SOFTWARE is not fault-
tolerant and is not designed, manufactured or intended for use or resale as on-
line control equipment in hazardous environments requiring fail-safe
performance, such as in the operation of nuclear facilities, aircraft navigation or
communication systems, air traffic control, direct life support machines, or
weapons systems, in which the failure of the SOFTWARE could lead directly to
death, personal injury, or severe physical or environmental damage ("High Risk
Activities"). Cedrus and its suppliers specifically disclaim any express or
implied warranty of fitness for High Risk Activities.

10. WAIVER OF RESPONSIBILITY FOR MISUSE.

The SOFTWARE can process copyright material and has no way of knowing if
such processing is in breach of copyright law. You agree that it is your
responsibility to ensure that you only process material for which you own or
have licensed the copyright and, further, to indemnify and hold harmless
Cedrus from any claim whatsoever relating to your improper use of the
SOFTWARE to process copyright materials.

11. MISCELLANEOUS.

This EULA represents the complete agreement concerning this license. The
acceptance of any purchase order placed by you is expressly made conditional
on your assent to the terms set forth herein, and not those in your purchase
order. If any provision of this EULA is held to be unenforceable, such provision
shall be reformed only to the extent necessary to make it enforceable. This
EULA shall be governed by American law in the State of Arizona (except for
conflict of law provisions). The application the United Nations Convention of
Contracts for the International Sale of Goods is expressly excluded.
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Index

ADB 21, 42,47, 65
Apple Desktop Bus (See ADB)
Apple Sound Chip 37, 52
Auditory (See Sound)
Background
color 41, 46, 62
Cancelling an experiment 44
Clear (See Delete)
Close 39
Codes
attached to trials 16, 56
delete 17, 30, 41
edit 17
editor 16, 30, 42
keyword 47, 52
new 16, 30
using 15-17
value 16, 30
Collected data

post-processing 15
save 9, 14, 15, 30, 43, 44, 55

Color switching (See Instant
Switching)
Color table 26
Copy 40
Cut
selected item 40
Debouncing time 42

Delete
code 17, 30
code value 17, 30
response 29

selected item 41
Digital output 7, 37, 49, 62
Excel 39, 60
Feedback 11, 15,17, 34
File Info button 34
LP.I 38
Input 19-24, 41, 42, 44, 47, 49, 62
Input device 43
Instant Switching 26-27, 36, 51
Internet 3
Interrupts 63
LCD 27
Liquid Crystal Display (See LCD)
MACES3 37
MacWrite 11 39
Microsoft Excel (See Excel)
Multiple pictures 36

National Instruments 7, 21, 22, 37-38,

42,44,47, 62

Open
experiment 5, 8, 38, 46, 59
picture file 7, 9, 59

Optical drive 55

Output (See Digital Output)
Palette 26

Paste 40

Picture
digitized 62
display time 8, 62
drawing 26, 51



drawing time 62 file 6

file 9, 35, 39, 54, 58, 59, 60 file format 45-54, 60
position 8, 35, 50, 59 file type 39
preview 8, 35, 51 loading 2, 38, 54, 59
size 8, 35, 50, 59 sample 2
Portable 27 saving 39
PowerBook 21, 23,27 Set Presentation 35
Programming 6 Sound 36
QuickDraw 41 SoundEdit 36
Quit 39, 59 Stopping an experiment 44
Random seed 53 SuperPaint 57
Randomization 53 Support 3
Reaction time (See Timing) Switches 42, 62
Read Me file 2 SyQuest 55
Refresh (See Video refresh) TeachText 2
Response TickCount 19-20, 47
accepted 7, 9, 31 Time Manager 19-20, 47, 65
character case 6 Timing 19, 43, 47, 65
zgiiicsf ;1, i%’ 17, 49 Video refresh 25-26
cut 40 Visual (See Picture)
defining 5 Visual stimulus 5,7, 9, 14, 17, 26, 31,
delete 29 46,59, 60, 61, 62
edit 29 voice key 23
editor 6, 29, 42
input device 42
keyword 48
new 6, 29
timing 43

response boxes 22
Results File (See Collected data)

Save
collected data 9, 15, 30, 43, 44, 55
Excel file 60
experiment 6, 12, 39, 45, 55, 59
picture 58
tree 59

Scanned images 62

Script
script suffix 6
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